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1 For users in a hurry 

1.1 Five easy steps to a finished CD/DVD 
With Nero Burning ROM 7 you can quickly and easily create your own discs and 
copy (non-copy-protected) discs. 

With Nero Burning ROM 7, you have a powerful burning software which enables 
you to easily burn data, music and videos onto discs. Nero Burning ROM 7 is 
the ideal software for power users - making it possible to work individually to a 
large extent. You have full control over the projects you want to burn and you can 
specify the file system, the length of the file names and the required font. You 
want to change the name of the disc? No problem, Nero Burning ROM 7 will 
assist you and provide you with several options. Even if you want to burn projects 
with unusual formats, Nero Burning ROM 7 assists you and enables you to 
create discs which can be read by both Apple and Windows computers. UDF 
format discs are also no problem. You can customize the tool bar and change the 
shortcuts of Nero Burning ROM 7 - in other words, you have a program which is 
as individual as you are. Despite the scope and the vast ability of Nero Burning 
ROM 7, it remains an easy-to-use burning program which creates your own discs 
in just a few easy steps. First select the disc type (a type supported by your 
device) to be burned (CD / DVD / Blu-ray / HD DVD), then select the type of 
project before adding the required data, and then you are ready to start burning - 
quickly and reliably, in proven Nero quality. 
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Step 1: Launching the program 
Start Nero Burning ROM 7 using the command sequence 'Start' >'All programs' 
> 'Nero 7 Premium' > 'Audio' / 'Data' > 'Nero Burning ROM'. 

The program starts with the window in which you select the media type and 
specify the compilation type. 

 
  

Step 2: Selecting the media type 
If you have installed a recorder that can burn a number of media types (e.g. CDs, 
DVDs), then click on the drop-down list box and select the media type to be 
burned. 
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Step 3: Specifying the compilation type 
Select the desired compilation type. The window in the compilation area will 
display the possible compilations for the media type selected. For example, to 
burn an Audio CD you must use the media type 'CD' and to burn a DVD-Video 
you must use the media type 'DVD'. 

 
  

Click on the 'New' button to finish selection of the compilation. 

 
  

The Nero Burning ROM 7 file browser opens in which you select the files to be 
burned. 
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Step 4: Running a compilation 

 
  

Compiling the files is child's play: Select the desired files on the right-hand side of 
the file browser and drag them to the left-hand side. Repeat this step until all of 

the files are in the compilation area of the file browser. Click on the  icon 
to switch to the burning area. 

 
  

The Nero Burning ROM 7 file browser is configured as standard to show the file 
structure of your PC on the right-hand side and the files to be burned on the left-
hand side. 
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If there is no file browser open yet, you can repeat this step by clicking on the 

 icon. 

  

You can tell whether the data will fit on the disc or the disc will be too small by the 
color of the full-o-meter. If the color of the full-o-meter is green, the data will fit on 
the disc. 

 
  

If the color is yellow, the data might fit on the disc. This depends on the disc 
inserted. Commercially available CDs, for example, are available with a capacity 
of 650 MB and 700 MB, i.e. in the example shown the data would fit on a CD with 
700 MB, but not on a CD with 650 MB. 

 
  

If the color is red, the data will not fit on the disc unless you have inserted a 
special size of disc, for example a CD with 800 MB. 

 
  

Step 5: Starting the burn process 
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On the 'Burn' tab you can make the final settings before the burn process. Note, 
however, that all of the settings are preset as standard to the most suitable value. 
Insert the disc and click on the 'Burn' button. 

 
  

The burn process is started; while it is running you can specify whether the files 
burned onto the disc should be verified and/or the PC shut down after the burn 
process (provided this is technically possible and you have the administrator 
rights required for this). 
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The outcome of the burn process is displayed once it is finished. Click on 'OK' to 
finish or on 'Burn again' if the compilation should be burned again. 

 

1.2 Copying a disc in four easy steps 
Step 1: Launching the program 

Start Nero Burning ROM 7 using the command sequence 'Start' >'All programs' 
> 'Nero 7 Premium' > 'Audio' 'Data' > 'Nero Burning ROM'. 

The program starts with the window in which you select the media type and 
specify the compilation type. 
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Step 2: Selecting the media type 
If you have installed a recorder that can burn a number of media types (e.g. CDs, 
DVDs), then click on the drop-down list box and select the media type to be 
copied. 

 
  

Step 3: Specifying the compilation type 
Select the compilation type 'CD Copy' or 'DVD Copy' according to the media type 
selected. 

 
  

Step 4: Starting the burn process 
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A: Direct copy (only for systems with two drives)   
Insert the disc to be copied in the source drive and the empty disc in the target 
drive and close both trays. Click on the 'Burn' button to start the copy process. 

B: Copy via image file (for systems with one drive)  
Insert the disc to be copied in the drive and close the tray. Click on the 'Burn' 
button to start the copy process. 
  
The burn process is started; while it is running you can specify whether the files 
burned onto the disc should be verified and/or the PC shut down after the burn 
process (provided this is technically possible and you have the administrator 
rights required for this). 

 
  
The outcome of the burn process is displayed once it is finished. Click on 'OK' to 
finish or on 'Burn again' if the compilation should be burned again. 
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2 General information about Nero Burning 
ROM 7 

2.1 Media supported by Nero 
Nero Burning ROM 7 is able to burn different types of media. Both DVDs and 
CDs can be burned with a DVD recorder. Only CDs can be burned with a CD 
recorder. 

The following table shows the possible compilations for the various media types. 

  
CD DVD 
CD-ROM (ISO) DVD-ROM (IS0) 
Audio CD DVD Copy 
Mixed Mode CD  DVD-Video 
CD EXTRA DVD-ROM (Boot) 
CD Copy DVD-ROM (UDF) 
Video CD DVD-ROM (UDF/ISO) 
Super Video CD  
miniDVD  
CD-ROM (Boot)  
CD-ROM (Hybrid)  
CD-ROM (UDF)  
CD-ROM (UDF/ISO)  

2.2 Nero Express 7 

2.2.1 Differences to Nero Burning ROM 7 

Nero Express 7 is an assistant-driven application based on Nero Burning ROM 
7. 

You can switch from Nero Burning ROM 7 to Nero Express 7 at any time during 
compilation of a project if the compilation in question is also to be burned using 
Nero Express 7.  

  

If the  icon is activated, you can switch to Nero Express 7. 

If the  icon is deactivated, you cannot switch to Nero Express 7. 
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Even though Nero Burning ROM 7 can burn a greater number of compilations 
than Nero Express 7, there are also compilation templates that are found 
exclusively in Nero Express 7: 

! MP3 CD and MP3 DVD 

! WMA CD and WMA DVD 

! Nero Digital Audio CD and Nero Digital Audio DVD 
  
You can still burn these compilations using Nero Burning ROM 7. To do so, 
simply select Data CD or Data DVD as the compilation and add MP3, WMA or 
Nero digital audio files. 
 

With Nero Express 7 you can burn all of the compilations marked with an X in 
the following table. 

  
 CD DVD 

Data disk X X 
Audio CD X  
MP3 disk X X 
WMA disk X X 
Nero Digital Audio X X 
Video CD X  
Super Video CD X  
DVD-Video  X 
Copying a disc X X 
Image file X X 
Saved compilation X X 

  

You will find further information about using Nero Express 7 in the manual 
written especially for Nero Express 7. 
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3 Creating a CD 

3.1 Data CD 
You can save all kinds of data on a data CD, i.e. these compilations can be used 
for all file types and every kind of original file can be burned. 

You can burn a data CD using the following compilations: 

! CD-ROM (ISO) 

! CD-ROM (UDF) 

! CD-ROM (UDF/ISO) 

  

A special feature of data CDs is the option of creating a multisession CD. This 
means that the CD does not have to be written in one session (as with audio CDs 
and DVD videos, for example), instead it can be written in a number of sessions 
until it is full. 

3.1.1 Creating a CD-ROM (ISO) 

1. Start Nero Burning ROM 7. 

2. If you have installed a recorder that can burn a number of media types (e.g. 
CDs, DVDs), then click on the drop-down list box and select the media type to 
be copied. 

 
  

3. Select the 'CD-ROM (ISO)' compilation, thereby bringing the 'Multisession' tab 
to the foreground. Select the desired multisession option.  
Start Multisession disc: A multisession disc will be started, i.e. you create the 
first session and can burn further sessions later once the first session has 
been burned. All of the burned sessions are visible later in the drive and you 
can access all of the data.  
Continue Multisession disc: A further session will be burned onto a disc 
already burned with at least one session. All of the burned sessions are visible 
later in the drive and you can access all of the data. If you select this option, 
there must be a multisession disc in the recorder.  
No Multisession: A multisession disc will not be created. This option still 
enables the disc to be written until it is full. Note, however, that only the last 
session will be visible then and you will only have access to the data from this 
last session. 
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Additional information on the multisession options and the other tabs can be 
found in the chapter 'Background information for advanced users'. 

  

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

  

5. Select the desired files on the right-hand side of the file browser and drag 
them to the left-hand side. Repeat this step until all of the files are in the 
compilation area of the file browser. 

 
  

6. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.1.2 Background information for advanced users 

This chapter describes the tabs not explained in the previous chapter (see the 
relevant subsections) as well as providing additional information on multisession 
CDs and describing the ISO and UDF file systems: 
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3.1.2.1 Additional tabs for data CDs 

On the 'ISO' tab you can toggle between Mode 1 and Mode 2/XA format as 
required. You should not need to verify the format – in the past there were 
problems with CD drives that could not read Mode 1 CDs, but very few of these 
drives will still be in use today. If these options are grayed it means that selection 
is not logically meaningful at present. Mixing Mode 1 and Mode 2/XA tracks on a 
CD would result in an unreliable and potentially unreadable CD format. In the 
'File/Directorynames length‘ section you can specify the ISO level for the length 
of the names. Up to 31 characters are permitted for Windows 95 and higher. 
Names cannot be more than 11 characters long for Windows 3.1 (8 for the name 
and 3 for the extension). ISO Level 2 will be best in most cases – if you know that 
the CD must also be readable on a Windows 3.1 system then you should select 
Level 1. 

On the 'Label' tab you can give your CD a name and overtype the default name 
'New'. You can use letters A-Z, digits 0-9 and the underscore character (_) – 
diacritics (accents) and spaces are not supported. 

On the 'Dates' tab you can specify the date of the compilation and of its files. The 
current date and time are entered for the compilation as default, also the creation 
date of the files. 

Use the 'Misc' tab to specify which files will be buffered in the cache. Files that 
are on slow media (floppy disks and network drives) and are very small are 
moved to the cache by default. You specify the location of the cache on the 
Cache tab in the File menu (Preferences option). 

3.1.2.2 How are Multisession CDs structured? 

This chapter explains the background to Multisession CDs and is pretty technical 
– it is intended mainly for users who already have some experience of CD 
burning and want to know a little more. The 'normal' user who just wants to create 
a Multisession CD with Nero Burning ROM 7 can skip this chapter. 

The ISO file system has a very useful feature that helps us to create Multisession 
CDs: The way files are stored in ISO tables of contents is that the absolute start 
block of each file and the file’s length in blocks is given. Absolute means that all 
blocks in all CD tracks are numbered sequentially. 

So what happens when a file’s start block belongs to a different track than the 
one where the TOC you want to create is located? No problem! CD-ROM drivers 
and recorders will simply read the file from another track. 

CDs are written session by session and track by track, so of course only tracks 
that have already been written can be addressed. This is why a reference track 
must be specified first when creating Multisession ISO CDs with Nero Burning 
ROM 7. Nero Burning ROM 7 reads this track in and remembers the positions of 
the files that are on it. At the next write session these positions are then re-written 
for unchanged files. 

  

Additional Multisession information on the CD 

When a new Multisession CD is started, Nero Burning ROM 7 saves not just the 
files and folders but also their source location on the hard disk. When a 
Multisession compilation is updated, this additional information is used to 
automatically replace, add or delete modified files. 
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Multisession CDs can still be created even if there is no additional Nero Burning 
ROM 7 information on the reference track. The disadvantage of this however is 
that the references to the hard disk which we mentioned above will not be known 
to Nero Burning ROM 7 and so there can be no automatic update. 

3.1.2.3 Creating a data CD (not multisession) 

The procedure for creating a data CD without multisession is identical to the 
procedure described in the chapter 'Creating a CD-ROM (ISO)'. You simply have 
to check the option 'No Multisession' on the 'Multisession' tab. 

Please note that when a CD is burned without a multisession, a table of contents 
(TOC) for the CD is created at the end of the burn. If the 'Finalize CD‘ option is 
selected the CD is write protected and no further burning is possible. If this option 
is not selected then further sessions can be burned but only the last session is 
visible, so the CD looks like there’s nothing else on it – not so! We suggest that 
you use the 'Creating a data CD (with multisession)' option when creating a data 
CD with several sessions. 

3.1.2.4 Creating a data CD (with multisession) 

The procedure for creating the first session of a data CD with multisession is 
identical to the procedure described in the chapter 'Creating a CD-ROM (ISO)'. 
You simply have to check the option 'Start Multisession disk' on the 'Multisession' 
tab. 

The procedure for creating the second and each subsequent session of a data 
CD with multisession is identical to the procedure described in the chapter 
'Creating a CD-ROM (ISO)'. You simply have to check the option 'Continue 
Multisession disk' on the 'Multisession' tab and insert the CD containing the 
existing sessions in the recorder. 

  

If you want to create a data CD that consists of several sessions, we advise that 
you create a Multisession CD. Every complete write process with Nero Burning 
ROM 7 on a CD, from inserting the CD you want to write to the CD being ejected, 
generates a session on the CD. A session in turn contains one or more tracks. All 
CDs with several sessions are 'Multisession CDs'. 

  

There are basically two types of Multisession CD: 

! Multisession CD for linked files, e.g. for backups 

! Multisession CD for independent files 

  

Multisession CD for linked files 
Multisession CDs are advisable, say, when making a weekly Backup of a number 
of folders on a CD. 

When an ISO compilation is created the required folder is written to the CD in 
every new session. Since only a few files may have changed, writing the entire 
folder again would have the following disadvantages: 

! Burning would take an unnecessarily long time because redundant data are 
being written each time. 
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! Valuable CD space would be wasted as the same data is copied a number of 
times. 

With a CD-R, data can only be written to a CD but cannot be deleted or changed, 
so the following procedure is used with Multisession CDs: 

Instead of writing the unchanged data again with every session (i.e. every backup 
procedure), Nero Burning ROM 7 only writes cross-references to a previous CD 
track which contains the unchanged file. Only the changed files are completely 
re-written. 

By activating the two checkboxes 'Replace files in compilation' and 'Add new files 
to compilation' in the 'Options' section you will ensure that this actually happens. 

Of course when individual sessions are linked to one another there must be some 
way of ensuring that the tracks (which have a definite connection to an existing 
CD) are not written to another CD by mistake. This would make all files with 
references outside the tracks unreadable later on! For this reason Nero Burning 
ROM 7 checks that the correct CD has been loaded for burning. If it hasn‘t, then 
the CD that has been loaded in error is ejected. 

Multisession CD for nonlinked files 
If the files in the file session you wish to burn are so small that further files can be 
added, and if you want to use all of the space on the CD, you can create a 
Multisession CD. 

By clearing the two checkboxes 'Replace files in compilation' and 'Add new files 
to compilation' in the 'Options' section you will ensure that Nero will not search 
for links to existing files on the CD. 

3.1.2.5 The ISO file system 

Nero Burning ROM 7 normally writes ISO data in the CD sector format Mode 1. 
However Nero Burning ROM 7 also supports the so-called 'XA-Format' for ISO 
data. The XA format is an extension of ISO structures and can only be burned 
onto the CD in 'Mode 2' (another CD sector format). 'Normal' ISO Mode 1 tracks 
behave just like Mode2/XA tracks when read under DOS/Windows and using 
modern CD-ROM drives. 

The latest CD-ROM drives can easily read Mode 1 and Mode2/XA-CDs. However 
there are still some CD-ROM drives around that cannot read the Mode 1 CDs 
correctly. Owners of these older drives are advised to write data in the 
Mode2/XA-format. 

  

ISO9660 
ISO9660 is a file system that was designed with the aim of creating a file system 
that is as system-independent and so as compatible as possible. Discs with 
ISO9660 as the file system can be read on all operating systems. 

ISO9660 supports filenames in 8.3 format in Level 1 (8 characters for the 
filename and 3 for the extension) and directory names 8 characters long. Only 
characters A-Z, 0-9 and the underscore (_) are allowed. The maximum interleaf 
depth is restricted to 8 levels (including root directory).  

A total of 31 characters are allowed in Level 2 and can be read by Windows 95 
and higher, whereas DOS and Windows 3.1 usually have trouble handling the 
long filenames. 
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ISO9660:1999 
ISO9660 is a file system that was designed with the aim of creating a file system 
that is as system-independent and so as compatible as possible. The advantages 
of this file system lie in the length of possible file names (the ISO9660:1999 file 
system supports file names with a length of up to 207 characters) and the fact 
that restrictions on directory depth have been lifted. 

3.1.2.6 The UDF file system 

The UDF file system was developed when it became increasingly obvious that 
the ISO9660 file system used on CDs was no longer meeting the needs of 
rewritable media and DVDs. It was optimized mainly to accommodate large data 
volumes and to make it easy to modify an existing file system. 

Nero Burning ROM 7 can burn UDF and so-called 'UDF Bridge CDs', which 
contain both a UDF and an ISO9660 file system. The UDF file system can be 
read by, say, Windows 98 and Windows 2000 with no special drivers. In case of 
doubt, Windows 2000 and Windows 98 also read the UDF file system if both an 
ISO9660 and a UDF file system are detected on the medium. Writing in UDF 
format is particularly important when burning DVDs because UDF is the preferred 
operating system for these media. 

3.1.2.7 The UDF/ISO file system 

The big advantage of a UDF/ISO Bridge CD is that the data comply with both the 
UDF standard and the ISO standard. The data are only added to the compilation 
once and Nero Burning ROM 7 automatically creates a UDF and an ISO table of 
contents. These two tables of contents allow the CD to be used as a Bridge CD. 
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3.2 Audio CD 

3.2.1 Creating an audio CD 

An Audio CD is a CD that contains music files and that can be played with any 
regular CD player which you can buy in a store – the songs on the CD must 
either be in CDA format or be converted to this format. 
  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'Audio CD' compilation, thereby bringing the 'Audio CD' tab to the 
foreground. On this tab you can make certain settings. 

  
 
General' area  
Normalize all audio files: This check box activates a filter that equalizes the 
volume of the audio tracks to be burned. This is particularly recommended if 
the audio tracks to be burned are from different sources, as the differences in 
volume may then be significant.  
No pause between tracks: This check box defines whether there should be a 
pause of 2 seconds between the tracks on the audio CD or whether the tracks 
should transition from one to the next without pause as is the case with live 
recordings.  
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CD Text' area  
Write on CD: This check box activates the option for writing CD text. CD text is 
additional information on an audio CD that displays the name of the CD, the 
individual songs and the artist on CD players that support this function.  
Title: The name of the CD is entered here.  
Artist: The name of the artist is entered here.  
  
Edition' area  
Here you can enter additional information. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the audio tracks to be 
burned. 

5. You have a number of options for adding the audio files.  
Option 1: You can insert audio files that are on a (non-copy-protected) audio 
CD.  
Option 2: You can insert audio files in the various formats (e.g. MP3, WAV, 
WMA) found on your PC.   
Select the desired audio files on the right-hand side of the file browser and 
drag them to the left-hand side. Repeat this step for all of the audio files. 
  

 
If you have added audio files, you can listen to the individual tracks. To do so, 
click on the 'Play' button. If you have added audio files that are on the hard drive, 
you can edit these tracks. To do so, click on the 'Edit' button to open the Nero 
Wave Editor 3. 

  

 
  

 
Additional filters and other options are available to you if you double-click an 
audio track. For further information, see the chapter 'Special audio filters'.  

  

6. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 
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3.2.2 Extracting audio files from a CD and then burning them 

If you have (non-copy-protected) audio CDs and wish to extract individual tracks 
from them to burn as a new audio CD, you can do so using Nero Burning ROM 
7. 

  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'Audio CD' compilation, thereby bringing the 'Audio CD' tab to the 
foreground. On this tab you can make certain settings. 

 
  
General' area  
Normalize all audio files: This check box activates a filter that equalizes the 
volume of the audio tracks to be burned. This is particularly recommended if 
the audio tracks to be burned are from different sources, as the differences in 
volume may then be significant.  
No pause between tracks: This check box defines whether there should be a 
pause of 2 seconds between the tracks on the audio CD or whether the tracks 
should transition from one to the next without pause as is the case with live 
recordings.  
  
CD Text' area  
Write on CD: This check box activates the option for writing CD text. CD text is 
additional information on an audio CD that displays the name of the CD, the 
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individual songs and the artist on CD players that support this function.  
Title: The name of the CD is entered here.  
Artist: The name of the artist is entered here.  
  
Edition' area  
Here you can enter additional information.  
  

4. On the 'CDA Options' tab you can define the strategy which Nero should use 
to handle the CDA files on an audio CD. This setting is for advanced users, for 
more information read the chapter 'Dragging & dropping audio track'. 

5. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

6. Insert the first original CD from which you wish to extract audio tracks into your 
CD-ROM drive and open this drive with the File Browser. 

7. Compile the CDA files for the first audio CD using 'Drag&Drop' editing by 
simply clicking on the required files in the File Browser and dragging them into 
the compilation window. 

Nero Burning ROM 7 now analyzes the source CD and the required CDA files 
and shows them in the File Browser. You will also see a small window in which 
you can enter a name for the source CD. This is for your own convenience so 
that when you select the reference strategy for writing Nero Burning ROM 7 
can prompt you to insert the named CD that it needs for writing. 

8. Now insert the second CD (the one with the audio files you want to burn) into 
your CD-ROM drive, select the File Browser and update the screen contents 
by pressing 'F5' (or select the 'Refresh' option from the 'View' menu). 

9. Open the drive with the File Browser and compile the CDA files for the second 
Audio CD with 'Drag&Drop' as described above in Point 7. 

10. Repeat the last three steps for each additional CD you wish to use. 

11. You are then ready to burn the CD. For more information on how to do this, 
please read the chapter 'Burning a disc'. 

  

 
If your burned Audio CDs crackle, hum or hiss, you probably have problems with 
the so-called 'Audio Jitter Effect'. This is due to basic problems which the 
hardware has when reading audio data and has nothing to do with Nero Burning 
ROM 7. 

3.2.3 Background information for advanced users 

Almost all CD players can only read CD-Rs, i.e. using rewritable CDs (CD-RW) is 
not recommended. Nero Burning ROM 7 writes the audio data to the CD-RW 
correctly but many CD players will not be able to play back the tracks. 

If possible, audio CDs should always be burned in the 'Disc-at-once' mode. This 
will make the most out of the features that Nero Burning ROM 7 offers and will 
avoid unwanted 'hiss and crackle‘ between individual tracks. 

A CD that contains music files in a variety of different formats (say MP3 or WMA) 
is strictly speaking an audio CD as well, but since a CD player cannot read these 
formats and play them back, these CDs are not referred to as Audio CDs. 

Nero Burning ROM 7 does not mind what audio format the files are in because 
compressed files (e.g. MP3, mp3PRO, WAV, WMA or AIF) are automatically 
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converted prior to burning so that they can be burned in CDA format. However 
decoding these files takes a certain amount of time and so the burning speed 
may have to be matched to the PC’s power and computing processes. 

Although writing Audio CDs with Nero Burning ROM 7 is really simple, it is worth 
spending a few moments thinking about your source medium. There are basically 
two ways of creating Audio CDs. With one method the audio tracks come from an 
Audio CD and with the other the audio files are on a hard disk. 

! To copy an existing Audio CD, you will find all the information you need in the 
chapter 'Copying a CD'. 

! If you wish to use tracks from an existing Audio CD and/or tracks from a 
number of Audio CDs, then there are several strategies with which Nero 
Burning ROM 7 can handle the audio files. You will find further information 
about these strategies in the chapter 'Source medium is CD/DVD drive'. The 
information you require about burning will be found in the chapter 'Burning a 
disc'. 

! If you want to use audio files that are on your hard drive, then the chapter 
entitled 'Source medium is hard disk' will explain the advantages of this option. 
The information you require about burning will be found in the chapter 'Burning 
a disc'. 

  

 
Music CDs with a special copy protection have been around on the market for 
some time now. These CDs cannot be played or copied with a normal PC. If you 
experience problems with copying, please make sure that you are not using CDs 
of this type. You can identify this from a note on the cover of the original CD. 

3.2.3.1 Source medium is CD/DVD drive 

Dragging & dropping audio tracks 
When dragging & dropping audio files that are on a CD (CDA) the user has a 
basic choice of four different strategies with which Nero Burning ROM 7 can 
handle the CDA files. The strategy is selected on the 'CDA Options' tab. You will 
see this tab in the 'New Compilation' dialog box which opens when you create a 
new compilation. If a compilation is already open, select your required strategy or 
check the selected strategy in the 'File' menu with the 'Compilation Properties' 
option. 

The 'General Settings' section offers you a choice of four different strategies: 

! Diskspace strategy (the default)  
With this strategy the CDA files are buffered in Nero Burning ROM 7's cache 
directory if sufficient space is available. If no space is available then a track 
reference is created. 

! Tempfile strategy  
With this strategy the CDA files are buffered in Nero Burning ROM 7's cache 
directory if sufficient space is available. If no space is available, an error 
message is displayed. 

! Reference strategy  
The CDA files are handled as track reference. The source medium can only be 
a CD/DVD drive, not a recorder. 

! Device dependant strategy  
CDA files are handled as track reference where possible, otherwise the 
tempfile strategy is used. 
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The diskspace and tempfile strategies can be used to burn in 'Disc-at-once' 
mode. We advise that you use one of these two strategies. 

The reference strategy can only be used for 'Track-at-once' burning and can only 
be read by CD/DVD drives, not by recorders. The reason why 'Track-at-once' 
must be used with this strategy (it is preset) is that when you use files that are on 
an interchangeable medium you may need to switch the source CD if the audio 
files come from different source CDs or if a track has to be approached at a 
remote read position on the source CD. This can mean a long wait between 
tracks however. In the 'Track-at-once' mode the wait between tracks can be any 
length of time without ruining the target CD. 

The burning mode that can be used with the device dependant strategy depends 
on the source medium, i.e. if the tracks are from a CD/DVD player, then only a 
reference is created and only 'Track-at-once' can be used. 

The chapter 'Extracting audio files from a CD and then burning them' explains 
how to burn compilations created with drag&drop editing. 
  

Copying audio tracks 

Copying CDA files to a hard disk offers the user more ways of using audio files. 
Unlike drag&drop, tracks can be converted to other formats. 

You will find full details about copying CDA files in the chapter 'Saving audio 
tracks'. 

3.2.3.2 Source medium is hard disk 

The advantage of burning audio files that are on a hard disk is that the CD can 
be written using 'Disc-at-once'. This means that you can get more out of the 
functionality of many recorders. For example, you can write CD text, specify the 
pause length or set additional index positions - these capabilities are only 
available with 'Disc-at-once'. 

The disadvantage is that the audio files need storage space on the hard disk. 
Depending on the audio format, around 10 MB per minute is required (in WAV 
format). If the files are compressed, e.g. in MP3 format, then the space 
requirement is cut by 90%. You can test the advantages of MP3 compression 
with Nero Burning ROM 7: You can convert up to 30 audio files to MP3 format. 
The chapter 'Saving audio tracks' tells you how to do this. 

3.2.3.3 Audio track properties 

Double click one (or more) audio files to open the 'Audio Information' dialog box. 
The tab offers you a wide variety of options. The main ones are: 
  

'Audio Track Properties' tab 

If your recorder supports the writing of CD Text, you can insert information for CD 
Text on this tab. 

You will find further information about CD Text in the chapter 'CD-Text'. 

You can also specify the length of the pause between tracks – the default pause 
between two tracks is 2 seconds. 
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You may feel that a pause between tracks is irritating, especially with live 
recordings. In this case set a pause length of 0 seconds. You can create a cross 
fade between two audio tracks, so the new number starts to play quietly while the 
current number is still playing. The current track will meld into the new track 
without a break. In this case activate the checkbox and specify the seconds for 
the fade. 

  

'Indexes, Limits, Split' tab 
The top part of the tab shows the progress of the audio track as a graph. 

The 'New Index' button sets a new index position at the selected position. For a 
CD player this is the position from which a new number starts and the player can 
also jump to it directly. 

  

 
Not all CD players support this function. 

  

The 'Split' button splits the audio track at the selected position, i.e. the track is 
physically split and becomes two (or more) tracks. These split tracks behave just 
like two independent tracks, so they can be named and the pause between them 
can be specified. 

The 'Play button plays the track from the selected position. While the track is 
playing the button switches to a 'Stop' button. 

The 'Delete' button deletes a selected new index position or the position for a split 
track. 

  

'Filter' tab 
You will see a number of filters on the left. The settings on the right change 
depending on the selected filter. 

To select a filter, activate its checkbox. The 'Test Selected Filters' button plays 
the audio track - this lets you check that you are happy with the result before you 
confirm the changes. 

3.2.3.4 CD-Text 

CD-Text is an extra item of information on Audio CDs which allows newer style 
CD players to display the CD title and the names of the tracks and artists. Your 
CDs will be played correctly even if your CD player does not support CD-Text. 
This is possible because the additional CD-Text information is stored in the CD’s 
so-called 'lead-in' area before the start of the audio data. 

Creating CDs with CD-Text is only possible when two conditions are met: Your 
recorder must support this function and the CD must be burned in the 'Disc-at-
once' mode. 

  

Creating an Audio CD with CD-Text 
CD-Text cannot be written to a CD unless this function is supported by the CD 
recorder you are using and the disc is written in the 'Disc-at-once' mode. A CD 
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can always be written in 'Disc-at-once' mode is the audio files are on a hard drive. 
The use of 'Disc-at-once' for compilations of Audio CDs depends on the selected 
strategy. You will find full details about this topic in the chapter 'Dragging & 
dropping audio track'. 

You can see whether your recorder can write CD-Text by selecting the 'Choose 
Recorder' option from the 'Recorder' menu. Now highlight the required recorder 
and read the information. 

  

 
In the same way you can also check whether your recorder supports 'Overburn', 
'Buffer Underrun Protection' and 'Disc-at-once'. 

  

Create an Audio CD as described in the chapter 'Extracting audio files from a CD 
and then burning them'. Please note the following points: 

! First, create a new audio compilation and drag the audio tracks you want into 
the compilation. 

! From the 'File' menu, select 'Compilation Properties' and on the 'Audio CD' tab 
check the 'Write CD-Text to the CD' checkbox. 

! Enter the title of the CD and its artist. These entries should not be longer than 
64 characters each. 

! In the compilation window click an audio track and enter the track’s title and 
artist on the tab. 

! Before writing, make sure that the 'Disc-at-once' mode is active. 

! Now click the 'Burn' button to write the Audio CD with CD-Text. 

  

Viewing CD-Text information 
You can view CD-Text on Audio CDs provided the selected read drive supports 
the reading of CD-Text. Recorders that can write CD-Text can do this. 

! Insert an Audio CD into the recorder. 

! Select the Save Tracks option from the 'Recorder' menu and choose the drive 
you require. 

! Now view the information you want in the ‘Title’ and ‘Artist’ columns. 

  

Copying CDs with CD-Text information 
Burning ROM 7 automatically copies the existing CD-Text if the reading drive 
and the selected recorder both support CD-Text. This applies to both image 
copies and on the fly copies. 

3.2.3.5 Special audio filters 

If you are unhappy with the quality of your audio tracks, Nero Burning ROM 7 
offers a range of filters can enhance the quality of the music tracks or change the 
tracks. The tracks are edited 'non-destructively' which means that the actual 
recording is not affected and only selections are set. The big advantage of the 
non-destructive method is that editing steps can be undone at any time and no 
additional audio data are created as you work. The audio files are not actually 
changed until they are written. 
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The filters are found in the 'Audio Information' dialog box on the 'Filter' tab. The 
window is opened by double clicking an audio track in the compilation window. 

Clicking the 'Test Selected Filters' button plays the audio track - this lets you 
check that you are happy with the result before you confirm the changes. 

! Normalizing  
If the audio tracks you are burning come from different sources then the 
volume of the individual tracks can be matched with this filter. All audio tracks 
in the compilation must have been selected for this filter to function correctly. 

! Declicking  
This is used to remove clicking noise when the audio file comes from a 
scratched vinyl. 

! Hiss Reduction  
This filter reduces the hiss of an audio file by removing the frequency 
components that are below a certain value. 

! Fade In  
This filter fades the audio track in from silence to full volume. 

! Fade Out  
This filter fades the audio track out from full volume to silence. 

! Stereo Widening  
This filter changes the intensity of the stereo effect with stereo recordings. 

! Karaoke  
This filter removes those parts of a song that are equal on both stereo 
channels. This is usually the vocal so this effect can be used for karaoke CDs. 
Please also refer to the chapter: 'Creating a Karaoke CD'. 

! Echo  
This effect provides a number of options for echo effects. 

! Equalizer  
This effect opens an equalizer so you can change the volume in different 
frequency ranges. 

  

 
The Nero Wave Editor 3 program which is part of the Nero Burning ROM 7
package provides you with even more filters and different audio editing options. 
To locate this program, select Start > Programs > Nero > Nero 7> Nero Wave 
Editor. 

3.2.3.6 Creating a Karaoke CD 

Creating a karaoke CD is rather complex because the karaoke filter must be set 
individually for each song. 

Create an Audio CD as described in the chapter 'Extracting audio files from a CD 
and then burning them'. 

Please note the following points: 

! First, create a new audio compilation and drag the audio tracks you want into 
the compilation. 

! In the compilation window, double click the song on which you want to set the 
karaoke filter. 

! Activate the 'Karaoke' filter on the 'Filter' tab. 
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! Specify the strength of the effect, the vocal balance and the quality of the 
conversion. 

! Click the 'Test Selected Filters' button to play the song and ensure that you 
are happy with the result. If you are not happy, change the effect strength and 
vocal balance, and test again. 

! Now click 'OK' to confirm your changes and close the dialog box. The name of 
the filter will appear in the 'Filter' column in the compilation window. 

! Now repeat the relevant points for each additional song. 

! Burn the karaoke CD when you have converted the songs. 

3.2.3.7 Recording records 

The Nero Wave Editor 3 lets you digitize records and save them on hard disk. 
You will find detailed instructions on how to do this in the quick guide and the 
program’s online help. When a record is recorded, two tracks are created (one 
from the from and one from the back). When these two tracks are burned the 
songs would not be individually controllable with a CD player. The track has to be 
split to make this possible. The chapter 'Splitting tracks' tells you how to do this. 

3.2.3.8 Splitting tracks 

Very long audio tracks can be split so that specific passages within the track can 
be triggered directly and/or become a separate track in their own right Long audio 
tracks are created, for example, when copying from record to hard disk, and they 
can be split before they are burned. 

  

1. Double click the required track in the audio compilation and click the Indexes, 
Limits, Split tab. 

2. Select the position where you want to split the track. 

3. Click the Split button. 

4. Click OK to close the window and confirm that you really want to split the 
track. 

3.2.3.9 Encoding 

Encoding an audio file means compressing it. With Nero Burning ROM 7 you 
are able to convert audio tracks to the most popular formats such as MP3 and 
mp3PRO. When they are burned, Nero Burning ROM 7 treats these formats just 
like other audio formats, so they can be used to create Audio CDs without 
difficulty, i.e. the compressed files are automatically decoded before they are 
burned. 

  

MP3 and mp3PRO 
Because of its good audio quality and small file size the MPEG3 audio format 
(with the extension MP3) has become the format most used to transmit audio 
data on the Internet. This is why Nero Burning ROM 7 also supports the burning 
of the popular MP3 files - Nero Burning ROM 7 handles them just like any other 
audio files and they are automatically decoded before burning. 
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You can test the Nero Burning ROM 7 mp3PRO encoder plugin as soon as 
Nero Burning ROM 7 is installed. You can encode up to 30 audio files or pieces 
of music from CD in the popular MP3 or mp3PRO format. 

mp3PRO files can be compressed to half the size of the conventional MP3 files 
with the same quality. These two file types have the same extension: mp3. 

  

MP3 Plugin 
The MP3 plugin uses the brand new and ultrafast MP3 encoder from the 
Fraunhofer Institut, the inventors of MP3. With the MP3 encoder you can 
condense your favorite pieces of music down to 10 % of their original size. And 
with virtually no audible loss of quality! Nero AG would like nothing better than to 
let its users create as many MP3 files as they want but we cannot do this for 
licensing reasons as the rights are held by Fraunhofer Institut and we would need 
to pay them fees. That’s why you can only test the encoder 30 times. If after that 
you wish to continue using the encoder, you will find further information about 
buying the mp3PRO plugin in the Webshop. 

  

mp3PRO Plugin 
The mp3PRO plugin uses the brand new and ultrafast mp3PRO encoder from 
Coding technologies, the inventors of mp3PRO. With the mp3PRO encoder you 
can condense your favorite pieces of music down to 5 % of their original size. 
And with virtually no audible loss of quality! 

Nero AG would like to offer you the opportunity to create any number of mp3PRO 
files, but for licensing reasons this is not possible, because Coding Technologies 
owns the rights to the encoder, which means that license fees would have to be 
paid. That’s why you can only test the encoder 30 times. If after that you wish to 
continue using the encoder, you will find further information about buying the 
mp3PRO plugin in the Webshop. 

The high processing power needed to decompress MP3 files means that the 
maximum possible burning speed will depend on the power of your PC. As a ‘rule 
of thumb‘ we can say that Pentium systems with a clock speed over 100Mhz 
should be capable of burning at twice the speed. Computers of Pentium II class 
and higher should be capable of burning 4 or even 8 times faster. Pentium III or 
IV PCs can achieve even higher burn speeds. 

  

 
MP3 files downloaded from the Internet may be damaged by transmission errors. 
Such problems may affect the sound. Nero Burning ROM 7 displays a warning 
telling you if damaged MP3 files have been added to an audio compilation. 
During writing, damaged files are logged with the warning message 'Lost sync 
within the MP3 stream‘. 

  

The MP3 library used by Nero Burning ROM 7 only supports the MPEG Layer3 
standard format at present. A similar error message appears if Nero Burning 
ROM 7 receives MP3 files for decoding and its MPEG3 library cannot process the 
file format. 

  

Nero Burning ROM 7 Creating a CD  •  33 

https://secure.nero.com/en/Secure.asp
https://secure.nero.com/en/Secure.asp


Audio CDs 
The encoding method described in this chapter is only suitable for tracks on 
Audio CDs. The encoding of audio files that are on hard drive is described in the 
chapter 'Encoding tracks that are on hard disk'. 

When you encode audio tracks you can save the encoded and saved tracks as 
an M3U playlist. You will find full details about this topic in the chapter 'M3U 
Playlists'. 

1. Load the Audio CD with the tracks you wish to encode in a CD drive. 

2. Select 'Save Track' from the 'Extras' menu. 

3. Select the drive that contains the CD with the tracks that are to be encoded. 

4. Highlight the audio tracks you wish to encode. 

5. Select the output file format by clicking the dropdown button and highlighting 
the required format. 

6. Click the 'Settings' button and specify the required encoding quality and 
bitrate. 

7. Choose the path for saving the audio file. If the audio file has no meaningful 
name, you can click the button with the three dots on it and rename the file. 

8. Click the Start button to start encoding - a window shows you how encoding is 
progressing. 

9. When encoding is complete, click Close to close the window. 

  

Encoding tracks that are on hard disk 
The encoding method described in this chapter is only suitable for audio tracks 
that are located on a hard drive. If you wish to encode tracks from an Audio CD 
please refer to the chapter '
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Audio CDs'. 

  

1. Select 'File Encoding' from the 'Extras' menu. 

2. Click the 'Add' button and select the directory containing the audio tracks you 
wish to encode. 

3. Highlight the audio tracks you wish to encode. 

4. Click the 'Settings' button and specify the required encoding quality and 
bitrate. 

5. Choose the path for saving the audio file. If the audio file has no meaningful 
name, you can click the button with the three dots on it and rename the file. 

6. Click the 'Start' button to start encoding - a window shows you how encoding 
is progressing. 

7. When encoding is complete, click 'Close' to close the window. 

  

Burning encoded files 
If the audio files you wish to encode are in a compressed format (MP3) then Nero 
Burning ROM 7 will decompress them automatically before burning. Just open 
an audio compilation and pull the compressed files you want into the compilation 
window with drag&drop. 

3.2.3.10 Decoding 

Converting compressed audio tracks is called decoding. Unlike encoding, with 
decoding it makes no difference what medium the audio tracks are on. 
  

Decoding audio tracks 
1. Select 'Encode Files' from the 'Extras' menu. 

2. Click the 'Add' button and select the directory containing the audio tracks you 
wish to decode. 

3. Highlight the audio tracks you wish to decode. 

4. Click the 'Settings' button and specify the frequency, bitrate and channels. 

5. Choose the path for saving the audio file. If the audio file has no meaningful 
name, you can click the button with the three dots on it and rename the file. 

6. Click the 'Start' button to start decoding - a window shows you how decoding 
is progressing. 

7. When decoding is complete, click 'Close' to close the window. 

3.2.3.11 M3U Playlists 

Nero Burning ROM 7 supports lists of audio files in the ASCII text format which 
are labeled as playlists and are in M3U format. They can be edited using 
Windows Notepad, for example. If you drag an M3U file into the compilation 
window, Nero Burning ROM 7 will add all the files on the playlist to the audio 
compilation. 
A great additional benefit with M3U playlists is that you can also specify 
information about the artists and titles in an audio file. In this way you can even 
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import title and artist information if the audio tracks have been saved as WAV 
files. WAV files do not normally allow artists and titles to be saved. When an M3U 
playlist with title and artist information is read by Nero Burning ROM 7 however, 
this information is also imported. 
M3U files can also be created, for example with the help of one of the MP3 play 
programs that are available on the market. Once you are happy with your music 
compilation it can be easily added to an audio compilation by dragging and 
dropping the playlist. 
  

Creating M3U Playlists 
Playlists can be created with Nero Burning ROM 7 when you save or decode 
Audio CDs. 

1. Insert the required CD into a CD drive. 

2. Select 'Save Track' from the 'Extras' menu. 

3. Select the drive with the CD inserted. 

4. Click the 'Options' button at the bottom of the window. 

5. Activate the 'Automatically generate a M3U playlist of stored audio‘ checkbox. 

6. Highlight the required audio tracks. 

7. Click the 'Settings' button and specify the required encoding quality and 
bitrate. 

8. Choose the path for saving the audio file. If the audio file has no meaningful 
name, you can click the button with the three dots on it and rename the file. 

9. Click the 'Start' button to start saving - a window shows you how the save is 
progressing. 

10. When copying is complete, give the playlist a name and click 'Save'. 

11. When the save is complete, click 'Close' to close the window. 

3.2.3.12 The Nero CD database 

Unfortunately most Audio CDs contain no information about the tracks that are on 
them – only Audio CDs with CD Text do this. When an Audio CD is created this 
means that the titles and artists of the tracks usually have to be entered 
manually. However Nero Burning ROM 7 has a built-in CD and title database 
designed to locate the titles, artists and all the tracks on an officially released 
Audio CD. This is achieved with a kind of ‘fingerprint’ on the CD. The information 
obtained in this way can be used or a range of purposes, such as: 

! Generating meaningful filenames when saving audio tracks (see also: 
Encoding). These filenames make it easier for you to compile your own Audio 
CDs and also provide the information that is printed on the cover by Nero 
Cover Designer. Information about the title and artist is also saved in the 
audio file provided the audio file format allows this. This is possible with MP3 
and WMA (MS Audio) files for instance, but not with WAV files. 

! Automatic addition of CD-Text when copying Audio CDs. This makes it 
possible to create CD copies that are in a way better than the original because 
they get more information. With the added CD-Text, an audio CD player with 
the right equipment can display the title and artist on a CD. 
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Importing the program database 
Depending on how your PC is configured, the database can take up to one day 
(!) of processing time to import! This is unavoidable because of the sheer size of 
the database and the large number of cross-references that Nero Burning ROM 
7 has to create. Once imported however, read access to the database is very 
fast. You can cancel the download at any time but we do not advise this, as it 
CANNOT be resumed. The database would have to be imported again and this 
would create double entries. 

1. Select 'Import Internet Database' from the 'Database' menu. 

2. Select the drive that contains the unzipped directory. 

3. Select the destination path for the database. 

4. When the import is complete you will see a window asking you if you wish to 
use this database as the Nero Burning ROM 7 program database. Click Yes 
to confirm your choice. 

  

Creating a user database 
Unlike the program database which contains information about published CDs, 
the user database is suitable for your own CD compilations. Creating a user 
database will ensure that information about CDs you have created yourself is not 
lost if the program database is overwritten. 

1. In Windows Explorer create a directory (target directory) to hold the user 
database. 

2. Select 'Create a New User Database' from the 'Database' menu and highlight 
the destination path for the new user database. 

3. When the import is complete you will see a window asking you if you wish to 
use this database as the user database. Click 'Yes' to confirm your choice. 

  

Configuring local Nero databases 
If when you imported the program database/user database you answered 'Yes' 
when asked if you want to use these as your new database(s), then the 
directories are entered automatically. However you can still review the settings on 
the relevant tab after you have imported the database(s). 
Before using the Nero database just take a little time to make sure that the 
settings are right. To configure these settings, select 'File' > 'Options' and then 
the 'Database' tab. You will see that there are three setting areas. 
  

Configuring the Internet database for reading 
As well as the local database, Nero Burning ROM 7 supports access to Internet 
databases with CD information that comply with the so-called CDDB standard. 
The free Internet CD database 'http://freedb.freedb.org' is preset as a preference 
- Nero Burning ROM 7 can access this directly on the Internet provided you 
have an Internet connection. 

! Select 'Options' from the 'File' menu and click the 'Database' tab. 

! Check that 'freedb.freedb.org' is preset as the read server in the 'Use Internet 
CD database' area. 

! Check that '/~cddb/cddb.cgi' is set as the address. 
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! Check that '80' is entered as the port. 
  

 
Remember that errors made in keying these parameters are likely to cause 
network failures. When you change these parameters you must also make sure 
that correct spelling is used. If you are using a proxy server you should enter the 
data required to access your proxy server in the Proxy Configuration dialog box. 
If you don’t have the necessary information, please ask your network 
administrator or Internet provider. If in doubt, try without a proxy server first. 
  

Configuring the Internet database for writing 
As well as downloading CD descriptions from the Internet database you can also 
make them accessible for other users. In this way you can help improve the 
quality of the Internet database when you own a CD that does not exist in either 
the local or the Internet database. This does not apply to CDs with tracks you 
have compiled yourself. However since it is unlikely that anyone else owns an 
identical CD, entries about such CDs should not be uploaded to the Internet 
database, as this would create meaningless CD entries. 

1. Select 'Options' from the 'File' menu and click the 'Database' tab. 

2. Activate the 'Submit E-Mail address' checkbox and check that 'freedb-
submit@freedb.org' is shown as the address. 

3. Enter your email address and the name of the SMTP server in the boxes 
provided. Please ask your network administrator or Internet provider for the 
name if you do not have this information. 

4. The 'Application Name' field shows the name and version of the program used 
to upload CD database entries – i.e. Nero Burning ROM 7 and the installed 
program version. 

  

 
When uploading CD entries remember that Internet databases are not normally 
updated immediately by the Internet database administrators as new entries 
must first be checked for plausibility. This means that if you upload a CD 
description today, it would probably not appear on the Net for several days. 
  

Configuring database settings 
Information from the CD databases can be used for a variety of purposes. You 
will find the necessary checkboxes in the lower section of the 'Database' tab: 

! Open the database during 'Save Track':  
When this checkbox is activated Nero Burning ROM 7 opens the database 
dialog box when the 'Save Track' option is selected from the 'Recorder' menu. 
You can now save the necessary information when you convert audio tracks 
to audio files. See also: 'Saving audio tracks'. 

! Open the database during 'CD Copy':  
When this checkbox is activated Nero Burning ROM 7 opens the database 
dialog box while the Audio CD is being copied. Nero Burning ROM 7 uses the 
information obtained in this way to create CD-Text. If you do not have a 
recorder that can write CD-Text, you can also use the information to create a 
cover for the CD with the Nero Cover Designer. The information about the 
audio tracks will be automatically added by Nero Burning ROM 7. 

! Open the database during '*.cda Drag&Drop':  
When this checkbox is activated Nero Burning ROM 7 opens the database 
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dialog box while Audio CDs are being dragged and dropped. There is no need 
for you to enter a name for the CD and the tracks added to the compilation. 

  

The database dialog box and how it is used in Nero 
Depending on how Nero Burning ROM 7 is configured the database dialog box 
appears on many different occasions, such as when copying Audio CDs or 
saving audio tracks to harddisk. This is done to get information about titles and 
artists on the CD and its tracks. This is then used to create CD Text information 
or to generate meaningful filenames when tracks are saved. The database dialog 
box first tries to get CD Text information about the loaded CD from the source 
drive. If this information is available, the dialog box is not opened. If CD-Text 
information cannot be obtained (for example because the CD contains no CD-
Text or the source drive does not support CD-Text), then the dialog box is 
opened. It now searches in the Nero CD database (if installed), in the user 
database (if installed) and in the Internet database if required. Another feature is 
that it searches through the database of the Windows CD player which can also 
manage a list of CDs that have already been detected. 
The search results are then shown in a list. The dialog box may find several 
different entries or none at all. There can be several different entries when 
different CDs have the same ‘fingerprint’. This 'fingerprint' is obtained from the 
start positions of the individual tracks, the number of tracks and the playing time 
of the CD. It is obvious that CDs with the same number of tracks, the same 
playing time and the same track start positions will also have the same 
'fingerprint'. Neither Nero Burning ROM 7 nor the Internet database can tell 
them apart. There will be different entries for an existing CD. It will be down to the 
user to select the correct entry. Other errors can be caused by the fact that many 
older recorders did not have the ‘Disc-at-once’ mode. Without this mode the start 
positions of the tracks on the CD can 'slip'. If an inaccurate CD copy like this is 
used for uploading, then there will be duplicates of CD entries, or CDs that are 
actually in the database will not be found. This is a problem you will unfortunately 
have to live with in the CD database. 
If there is no entry in the list of possible CDs and if no suitable entry can be found 
in the Internet database either ('Access Internet Database' button), then the only 
solution is to define your own entry. You can create this entry by clicking 'Create 
A New CD Entry'. Don’t forget to enter the title and artist for every track. This is 
particularly important if you intend to upload your CD entry to the Internet at a 
later time. There is no sense in ‘burdening‘ the Internet database with incomplete 
entries. 
However we recommend that you only make newly created CD entries available 
to the general public on the Internet for purchasable original CDs. Likewise, there 
is no sense in uploading descriptions of CDs you have compiled yourself as they 
will only clog up the Internet database and in any case no other user should own 
this special CD. Please remember too that you can only upload entries in ASCII 
characters to the Internet database. This database does not support special 
characters such as German ‘umlauts‘ or special Asian characters. Special 
characters should therefore be written out in ASCII notation, e.g. 'Marius Mueller 
Westernhagen' instead of 'Marius Müller Westernhagen'. 
The selected entry is used by Nero Burning ROM 7 as a source of information 
for artist and title entries and entered in the user database where it can be used 
for future access to the CD. If you do not wish to use an entry, click 'Cancel'. 
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3.3 Mixed Mode CD 
A Mixed-Mode CD is a CD with different file formats in a single session. A data 
track followed by one or more audio tracks (e.g. a soundtrack with PC games) is 
a typical example. Older audio CD players are often unable to recognize the data 
track as such and attempt to play it. The CD EXTRA format has been developed 
to combat this problem. Please refer to the section 'CD EXTRA'. 

3.3.1 Creating a Mixed Mode CD 

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'Mixed Mode CD' compilation, thereby bringing the 'Iso' tab to the 
foreground. On this tab you can select the data mode and the file system, 
among others. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. The file browser contains a compilation area for audio tracks and for data files. 
Click on the 'Data' button if you would like to insert files. Select the desired 
files on the right-hand side of the file browser and drag them to the left-hand 
side. Repeat this step until all of the files are in the compilation area of the file 
browser. 

  

 
You will find further information on adding data files in the chapter 'Creating a 
CD-ROM (ISO)'. 
  
6. Click on the 'Audio' button if you would like to insert audio files. You have a 

number of options for adding audio files.  
Option 1: You can insert audio files that are on a (non-copy-protected) audio 
CD.  
Option 2: You can insert audio files in the various formats (e.g. MP3, WAV, 
WMA) found on your PC.  
 
Select the desired files on the right-hand side of the file browser and drag 
them to the left-hand side.  
Repeat this step until all of the files are in the compilation area of the file 
browser. 

  

 
You will find additional information on adding audio files in the chapter 'Creating 
an audio CD'. 
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7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.4 CD EXTRA 
A CD in the CD EXTRA format (also known as an Enhanced CD) is a 
Multisession CD that consists of two sessions: the first session contains the audio 
files and the second session the data. 

Existing normal audio CD players play the first session as an Audio CD. The 
second session contains data files whose contents may relate to the audio track 
in the first session, for example with song lyrics and background information 
about the music, or they may just contain gimmicks in the form of video clips. The 
second session can only be used by PCs with a CD-ROM drive, it cannot be 
‘seen‘ by a normal CD player. 

3.4.1 Creating a CD EXTRA 

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'CD Extra' compilation, thereby bringing the 'CD EXTRA' tab to the 
foreground. You can use the text boxes on the 'CD EXTRA' tab to specify the 

Nero Burning ROM 7 Creating a CD  •  41 



album identification. This is particularly useful when the album is to comprise 
of several CDs. You can also specify the number of volumes in the album and 
the album set sequence number. The default for the number of volumes and 
the sequence number is 1.  
The Pictures button opens a dialog box where you can select two pictures to 
be saved on the front and back of the CD. You can also specify the color 
format for the encoding resolution for all of the pictures that will be written to 
the CD.  
A CD EXTRA can contain information in different languages. Click the Add 
beneath the 'Language' window to select these languages from a list of 
countries. You could enter the album title for each language, for example.  
You should specify at least one language. When you highlight a language you 
can enter a name in the 'Album Title' box. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. The file browser contains a compilation area for audio tracks and for data files. 
Click on the 'Data' button if you would like to insert files. Select the desired 
files on the right-hand side of the file browser and drag them to the left-hand 
side. Repeat this step until all of the files are in the compilation area of the file 
browser. 

  

 
You will find further information on adding data files in the chapter 'Creating a 
CD-ROM (ISO)'. 

  

6. Click on the 'Audio' button if you would like to insert audio files. You have a 
number of options for adding audio files.  
Option 1: You can insert audio files that are on a (non-copy-protected) audio 
CD.  
Option 2: You can insert audio files in the various formats (e.g. MP3, WAV, 
WMA) found on your PC.  
Select the desired files on the right-hand side of the file browser and drag 
them to the left-hand side.  
Repeat this step until all of the files are in the compilation area of the file 
browser. 

  

 
You will find additional information on adding audio files in the chapter 'Creating 
an audio CD'. 
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7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.5 Bootable CD and DVD 

3.5.1 Conditions 

A PC can only be booted from a CD when its BIOS supports this function (start 
sequence e.g. 'CD-ROM, C, A') or, if a SCSI CD-ROM drive is being used, the 
drive must be connected to a SCSI adapter with its own BIOS whose settings can 
be changed accordingly. (This will only work when there are no IDE harddisks 
present as these come before the SCSI adapter in the boot sequence.) 

If neither of these conditions is met then the PC cannot be booted from a CD-
ROM. 

Even so, not every operating system can be booted from a CD. During booting, 
Windows/98/Me and Windows /2000/XP write to the medium from which they are 
being booted. This is not possible with a CD and so the process is cancelled and 
the PC cannot be started. No provision for booting from a ROM medium was 
made when these operating systems were developed. When booting from a CD 
therefore, you can only start an operating system that does not write to the 
medium, such as 'MS-DOS' or 'Linux'. 

Bootable CDs are created according to the 'El Torito' standard. The CD contains 
a boot image and an ISO part. When the read driver for the CD-ROM drive and 
the 'Mscdex.exe' file have been installed, MS-DOS can access the ISO part of 
the CD which runs the rest of the installation routine. 
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3.5.2 Background 

Bootable CDs are created using the so-called 'El Torito' specification. This is an 
extension of the ISO Level 1, ISO Level 2, Joliet standard which controls the 
structure of Data CDs: A bootable CD consists of a boot partition and an optional 
ISO track. The format sees a boot section that contains the information needed to 
start the CD and a boot catalog. 
Such a CD can only be made from an existing bootable partition. The entire 
partition is copied to the CD so the CD must be smaller than 650 MB (or 700 
MB). 

There are three basic types of Boot CDs: Floppy Emulation, Harddisk Emulation 
and No Emulation. 

! With Floppy Emulation, a bootable floppy is needed to create the bootable CD. 
The size of the start data is limited by the capacity of the floppy disk (e.g.: 1.44 
MB). When starting, the Boot CD is assigned Drive A and the actual disk drive 
is treated as B. 

! Harddisk Emulation requires a bootable hard disk to create the bootable CD. 
The Boot CD is assigned drive letter C and the existing hard disks are 
incremented a letter, so C becomes D, D becomes E and so forth. During 
booting the CD behaves as if it were CD drive C. Up to 640 MB (or 700 MB) of 
boot data can be stored on a CD with this type of bootable CD. However this 
requires a harddisk partition with 640 (or 700) MB max. This partition must first 
be created if it does not yet exist. 

! With No Emulation, the drive letters are not changed. This type is used for 
bootable installation CDs. 

3.5.3 Template for making a bootable CD 

A 'template' in the form of a bootable drive is needed to make a bootable CD. 
There are basically three types of bootable CD: 

1. Floppy Emulation: Floppy Emulation requires a bootable floppy to make the 
bootable CD. When it is booted, the CD behaves as if the floppy were inserted 
in Drive A. The drive letters increment, so that Drive A: corresponds to the 
bootable CD. Floppy disk drive A: can be accessed as B: after booting. The 
size of the start data is basically limited by the capacity of the floppy disk (e.g.: 
1.44 MB). 

2. Harddisk Emulation: A bootable hard disk is required to create the bootable 
CD. When booted, the CD behaves as if the CD were Drive C:. Its 'old' Drive 
C: becomes Drive D:, its old Drive D: becomes Drive E: and so forth. Up to 
640MB of boot data can be stored on a CD with this type of bootable CD. Of 
course this means that the template drive must not be bigger than 640 MB or it 
will not 'fit' on the CD. So if you have a 200 GB hard disk with only one 200 GB 
partition for example, you will not be able to create a bootable CD from it 
without first re-partitioning your hard disk in a suitable way. This is a problem 
of principle and has nothing to do with Nero Burning ROM 7. 

3. No Emulation: This feature is only intended for use by out-and-out experts 
who require no floppy or harddisk emulation and wish to install their own 
device drivers. 'Windows 2000 CD' uses this method, for example. 

For Nero Burning ROM 7 the template for making a bootable CD can be either a 
logical drive (e.g. the C: drive) or a so-called 'Image File' of a drive. Image files 
contain the contents of a drive sector by sector as a file. Image files can be 
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created with packages such as 'Norton Disk Editor' or 'WinImage' and are usually 
very large (as large as the drive from which they were created, obviously!). 

3.5.4 Making bootable CDs 

You will find basic information about bootable CDs based on the 'El Torito' 
standard in the section entitled 'Background'; this section only describes how to 
create a bootable CD with Nero Burning ROM 7. 
  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'.  

 
  

3. Select the 'CD-ROM (Boot)' compilation, thereby bringing the 'Boot' tab to the 
foreground. 

4. In the upper section of the Boot tab (Source of boot image data) you can 
specify whether the template data for the bootable CD originate from a logical 
drive or a drive image files (refer to 'Template for making a bootable CD'). 

  

 
If your preferred logical drive does not appear on the list of drives on this tab, this 
is because the drive is bigger than 650 / 700 MB. This amount of data cannot fit 
on a CD so Nero Burning ROM 7 does not display these drive in the list. 
  

Please note furthermore that for operating systems as of Windows 2000 you 
need to have administrator rights in order to be able to access drives 'directly', 
which you will need to do if you are to create bootable discs. This requirement 
for direct drive access for operating systems as of Windows 2000 is imposed 
by Microsoft and is intended to protect against hackers who could otherwise 
gain access to the confidential data of other users. 

5. The lower part of the tab (expert settings) contains detailed settings for 'El 
Torito' standard compliant bootable CDs. These settings are normally grayed 
which indicates that Nero Burning ROM 7 makes the right settings for you 
automatically. When an image file is entered as the source of the boot image, 
Nero Burning ROM 7 cannot make the right settings automatically. If this is 
the case, or if you want to change the expert settings manually, you can enter 
all the parameters by hand. Activate the 'Enable expert settings' checkbox if 
required. You are of course now responsible for the CD working correctly later 
on. 

6. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

7. Select the desired files on the right-hand side of the file browser and drag 
them to the left-hand side. Repeat this step until all of the files are in the 
compilation area of the file browser. 
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You will find further information on adding data files in the chapter 'Creating a 
CD-ROM (ISO)'. 
  

 
  

8. Click on the  icon to switch to the burning area. You are then ready to 
burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.6 Video CD/Super Video CD 
The program Nero Vision 4 is most suitable for the creation of Video CDs and 
Super Video CDs. We therefore recommend that you use this program. If you 
would nevertheless like to use Nero Burning ROM 7 to create these discs, 
please read the next chapter. 

3.6.1 Creating a Video CD 

You can make Video CDs when the files are already in the MPEG-1 format or 
when other video formats are converted to it. Nero Burning ROM 7 contains a 
built-in MPEG-1 encoder with which MPEG-1 files can be created. 
  

1. Starten Sie Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 
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3. Select the 'Video CD' compilation, thereby bringing the 'Video CD' tab to the 
foreground. The 'Video CD' tab offers a number of options which you can use 
to tailor the Video CD to your specific requirements. The 'Create standard 
compliant CD' checkbox should be enabled to ensure that you make a Super 
Video CD that can be played in a DVD player. You specify the color format to 
which the video files will be converted in the 'Encoding resolution‘ section: Pal 
or NTSC. If you want to be able to add pictures to the video, then they can be 
copied to a separate directory. In this case check the ‘Store source pictures in’ 
checkbox. The 'Use CD-i application' checkbox is only intended for users with 
experience of CD-i applications. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. The file browser contains one compilation area for video and picture files and 
one for data files. Click on the 'Data' button if you would like to insert files. 
These may be text files or even a software player for your PC. Select the 
desired files on the right-hand side of the file browser and drag them to the 
left-hand side. Repeat this step until all of the files are in the compilation area 
of the file browser. 

 

 
You will find additional information on adding audio files in the chapter 'Creating 
an audio CD'. 

  

6. Click on the 'Video/Pictures' button to insert video and picture files. Select the 
desired files on the right-hand side of the file browser and drag them to the 
left-hand side.   
Repeat this step until all of the files are in the compilation area of the file 
browser. 

  

 
If an MPEG file does not have the correct characteristics of a VCD, Nero 
Burning ROM 7 detects the incorrect format and the user has three options: 
'Ignore Compatibility', 'Re-Encode the File' or 'Cancel'. 
Ignoring compatibility burns the file to the CD with no changes. This option is 
specifically aimed at experienced users. 
Re-encoding decodes the existing file, converts it to the correct resolution and 
Framerate and encodes it again. (Re-encoding is done before burning. This 
process requires both time and temporary memory space. 
Canceling interrupts the addition of the video file, i.e. it is not added to the 
compilation. 
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7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.6.2 Creating a Super Video CD 

You can make Super Video CDs when the files are already in the MPEG-2 format 
or when other video formats are converted to it. The DVD-Video plug-in is 
required for decoding and encoding in 'MPEG-2' format. This plug-in is included 
in the retail version and the web version. If you own another version of Nero 
Burning ROM 7, you can purchase the DVD-Video plug-in on the Nero AG 
website (http://www.nero.com/). 

  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'Video CD' compilation, thereby bringing the 'Video CD' tab to the 
foreground. The 'Super Video CD' tab offers a number of options which you 
can use to tailor the Video CD to your specific requirements. The 'Create 
standard compliant CD' checkbox should be enabled to ensure that you make 
a Super Video CD that can be played in a DVD player. You specify the color 
format to which the video files will be converted in the 'Encoding resolution‘ 
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section: Pal or NTSC. If you want to be able to add pictures to the video, then 
they can be copied to a separate directory. In this case check the ‘Store 
source pictures in’ checkbox. The 'Use CD-i application' checkbox is only 
intended for users with experience of CD-i applications. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. The file browser contains one compilation area for video and picture files and 
one for data files. Click on the 'Data' button if you would like to insert files. 
These may be text files or even a software player for your PC. Select the 
desired files on the right-hand side of the file browser and drag them to the 
left-hand side. Repeat this step until all of the files are in the compilation area 
of the file browser. 

  

 
You will find further information on adding data files in the chapter 'Creating a 
CD-ROM (ISO)'. 
  

6. Click on the 'Video/Pictures' button to insert video and picture files. Select the 
desired files on the right-hand side of the file browser and drag them to the 
left-hand side.   
Repeat this step until all of the files are in the compilation area of the file 
browser. 

  

 
If an MPEG file does not have the correct characteristics of a SVCD, Nero 
Burning ROM 7 detects the incorrect format and the user has three options: 
'Ignore Compatibility', 'Re-Encode the File' or 'Cancel'. 
Ignoring compatibility burns the file to the CD with no changes. This option is 
specifically aimed at experienced users. 
Re-encoding decodes the existing file, converts it to the correct resolution and 
Framerate and encodes it again. (Re-encoding is done before burning. This 
process requires both time and temporary memory space. 
Canceling interrupts the addition of the video file, i.e. it is not added to the 
compilation. 
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7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.7 miniDVD 
With Nero Burning ROM 7 you can burn a miniDVD if the DVD-Video title is 
already available. If, on the other hand, you would like to convert video files into a 
DVD-Video title, you can use Nero Vision 4 but not Nero Burning ROM 7. 

3.7.1 miniDVD erstellen 

In principal a miniDVD is the same as a CD-R or CD-RW written in UDF format 
with a DVD structure. It offers the same technical options and qualities as a DVD, 
can create chapters or animated menus and support subtitles and multiple audio 
tracks (including real digital multichannel sound). While compatibility with all DVD 
players is not guaranteed, miniDVDs can be played by computers without any 
problem. 

  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'miniDVD' compilation, thereby bringing the 'ISO' tab to the 
foreground. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. Select all available files of the DVD-Video title on the right-hand side of the file 
browser and drag them to the left-hand side. 
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6. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.8 Hybrid CDs 
A hybrid CD contains both files for PCs and Apple Macintosh computers 
according to the HFS standard. Nero Burning ROM 7 creates so-called 'non 
shared' Hybrid CDs. This means that if you wish to use files on the Mac and on a 
PC then they must be on the CD twice: Once in the ISO sector and once in the 
HFS sector. 

3.8.1 Creating a Hybrid CD 

 
If you want to make a Hybrid CD from a PC, the HFS input data must be on an 
SCSI harddisk connected to the PC. Remember however that the data on the 
SCSI harddisk can only be created with an Apple Mac computer. An SCSI 
harddisk with the HFS input data must be connected up to the PC before a 
Hybrid CD can be created. The SCSI harddisk must be connected and powered 
up before the PC is switched on. There must also be no duplication of SCSI 
device numbers. 

  

 
Caution: Neither the ISO data nor the HFS data nor both data together may 
exceed 640 MB as they will not fit on the CD. 

  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 
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3. Select the 'CD-ROM (Hybrid)' compilation, thereby bringing the 'Hybrid' tab to 
the foreground. Select the HFS partition from which you wish to add the data. 
If you do not see a HFS partition, it means that no SCSI hard drive containing 
HFS was found. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. Select the desired files for the PC on the right-hand side of the file browser 
and drag them to the ISO part of the hybrid CD on the left-hand side. 

6. Select the desired files for the PC on the right-hand side of the file browser 
and drag them to the HFS part of the hybrid CD on the left-hand side. 

7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.9 CD-ROM (UDF) 
The UDF file system was developed when it became increasingly obvious that 
the ISO9660 file system used on CDs was no longer meeting the needs of 
rewritable media and DVDs. It was optimized mainly to accommodate large data 
volumes and to make it easy to modify an existing file system. 

3.9.1 Creating a CD-ROM (UDF) 

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'CD-ROM (UDF)' compilation, thereby bringing the 'Multisession' tab 
to the foreground. Select the desired multisession option.  
Start Multisession disc: A multisession disc will be started, i.e. you create the 
first session and can burn further sessions later once the first session has 
been burned. All of the burned sessions are visible later in the drive and you 
can access all of the data.  
Continue Multisession disc: A further session will be burned onto a disc 
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already burned with at least one session. All of the burned sessions are visible 
later in the drive and you can access all of the data. If you select this option, 
there must be a multisession disc in the recorder.  
No Multisession: A multisession disc will not be created. This option still 
enables the disc to be written until it is full. Note, however, that only the last 
session will be visible then and you will only have access to the data from this 
last session. 

 
  

 
You will find additional information on the multisession options in the chapter 
'Background information for advanced users'. 

  

4. For advanced users: If you click on the 'UDF' tab you can select the UDF 
partition type and the UDF file system. If you wish to create a disc that is 
compatible with Xbox ™, check the appropriate box. 

5. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

6. Select the desired files on the right-hand side of the file browser and drag 
them to the left-hand side. Repeat this step until all of the files are in the 
compilation area of the file browser. 
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7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

3.10 CD-ROM (UDF/ISO) 

3.10.1 Creating a CD-ROM (UDF/ISO) 

The big advantage of a UDF/ISO Bridge CD is that the data comply with both the 
UDF standard and the ISO standard. The data are only added to the compilation 
once and Nero automatically creates a UDF and an ISO table of contents. These 
two tables of contents allow the CD to be used as a Bridge CD. 
  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'CD-ROM (UDF/ISO)' compilation, thereby bringing the 
'Multisession' tab to the foreground. Select the desired multisession option.  
Start Multisession disc: A multisession disc will be started, i.e. you create the 
first session and can burn further sessions later once the first session has 
been burned. All of the burned sessions are visible later in the drive and you 
can access all of the data.  
Continue Multisession disc: A further session will be burned onto a disc 
already burned with at least one session. All of the burned sessions are visible 
later in the drive and you can access all of the data. If you select this option, 
there must be a multisession disc in the recorder.  
No Multisession: A multisession disc will not be created. This option still 
enables the disc to be written until it is full. Note, however, that only the last 
session will be visible then and you will only have access to the data from this 
last session. 

 
  

 
You will find additional information on the multisession options in the chapter 
'Background information for advanced users'. 
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4. For advanced users: If you click on the 'UDF' tab you can select the UDF 
partition type and the UDF file system. If you wish to create a disc that is 
compatible with Xbox ™, check the appropriate box. 

5. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

6. Select the desired files on the right-hand side of the file browser and drag 
them to the left-hand side. Repeat this step until all of the files are in the 
compilation area of the file browser. 

 
  

7. Click on the  icon to switch to the burning area. You are then ready 
to burn the CD. For information on how to do this, please read the chapter 
'Burning a disc'. 

Nero Burning ROM 7 Creating a CD  •  55 



4 Copying a CD 

4.1 Direct copy or copy of an image file? 
Copying CDs is easy with Nero Burning ROM 7. All you have to do is decide 
how you would like to copy the CD: 

! Fast copy (on the fly) from CD/DVD-ROM drive to recorder. 

! Create the copy with the help of a temporary image file on the hard disk. We 
recommend that you read in the original CD using the recorder. 

The method you use for copying will depend on your particular requirements: we 
do not recommend either method a priori as they both have advantages and 
disadvantages. 

  

Choose copy over image if you 
! Feel that obtaining the best possible reproduction (particularly regarding audio 

index positions and general audio quality) of the original CD is important. 

! Have the extra time needed to produce a copy using an image file. 

! Have sufficient space for the image file on the hard disk. 

! Would like to make several copies of the same CD. 

! Think it likely that read errors may have occurred on the source CD (for 
example because scratches are clearly visible). 

! You only have a CD drive. 

  

Choose fast copy if you 
! Do not have much time to spare. 

! Do not have enough space for an image file on the hard disk (for example you 
will need about 10 MB per minute of audio data; on the other hand a data disk 
requires a large image file of several hundred GBs!). 

4.2 Copying using an image file 
There are three stages to copying using an image file. First of all Nero Burning 
ROM 7 reads the original CD from a CD drive and then, in the second stage, 
produces an image file on the hard disk containing all the information from the 
CD. In the third stage Nero Burning ROM 7 writes the image file already created 
onto an empty CD. 

This procedure guarantees the greatest possible insurance against data being 
supplied too slowly which could lead to defective blanks. With audio CDs this 
choice allows audio data to be corrected - something which would not be possible 
with simultaneous reading and burning. 
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A copy over image may consist of up to 8000 MBs so you should ensure that you 
have enough storage space on the hard disk selected. We also recommend that 
you save the copy over image on the fastest hard disk. If you click on the 
appropriate button Nero will automatically carry out a speed test of all your hard 
disks and provide you with the result. 

   

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the media type 'CD'. 

 
  

3. Select the 'CD Copy' compilation. 

4. Click on the 'Copy Options' tab and deactivate the 'On the fly' check box.  
Click on the drop-down list box and select the desired drive. We recommend 
that you read in the original CD using the recorder. 

 
  

5. Click on the ‘Burn’ button to create the image file. The burn window will appear 
and you can track the progress. 

6. The disc will be ejected once the image file has been created. Insert an empty 
disc in the drive and close the tray. The disc will then be burned and you can 
track the progress in the burn window. The outcome of the burn process is 
displayed once it is finished. Click on 'OK' to finish or on 'Burn again' if the 
compilation should be burned again. 
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4.3 Copying using a fast copy (on the fly) 
Nero can perform a fast copy (on the fly) straight from the CD-ROM to the 
recorder without using an "intermediate" image file. 

  

Some of the disadvantages in the following list do not apply to recorders with 
buffer underrun (buffer in idle state) protection. 

  

Advantage 
This feature, which is often desirable, allows faster copying and also requires no 
additional storage space on the hard disk. 

  

Disadvantage 
The advantage of speed may also become a disadvantage: 

! Firstly there must be a CD/DVD-ROM drive available which can supply data 
fast enough. For example if you want to burn 24x the input data must be able 
to be read in at least 24x (better with 32x) from the CD/DVD-ROM so that no 
buffer underrun occurs. It is not so easy to guarantee this because some CD-
ROM audio data reads considerably more slowly than "normal" data (Mode 1 
or Mode 2). For example there are modern 48x CD ROM drives which read 
audio data slower than 10x! 

! If errors occur when reading the CD - because there is a scratch on the CD for 
example - the error cannot possibly be eliminated by reading the appropriate 
point of the CD several times because, unlike the image file approach, there is 
no time (threat of buffer underrun). In such a situation there is nothing else 
Nero Burning ROM 7 can do but write the questionable data received or just 
null data. In other words direct copies are very susceptible to read errors! 

! Many CD/DVD-ROM drives are unable to provide information about the 
number and type of sessions. They can only give information on the number 
and type of tracks. This means that Nero Burning ROM 7 sometimes cannot 
prepare an exact copy of a CD. 

! Audio tracks may contain index positions. However these can only be 
identified if the appropriate point on the CD is being read. When producing a 
"disc-at-once" copy this information does have to be available before the burn 
process is begun. This means that with fast copies Nero Burning ROM 7 
cannot copy audio index positions at the same time. These will therefore 
inevitably be lost! 

! The quality of audio data read in may suffer here. Nero Burning ROM 7's 
method of copying a CD is such that some megabytes of data are read from 
the CD/DVD-ROM and then written onto the recorder. This inevitably occurs 
because Nero Burning ROM 7 does not have enough main memory to record 
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the entire CD (sometimes more than 700 MB!) and no image file is to be made 
(even a fast copy (on the fly)). The CD/DVD-ROM drive often reads at higher 
speed than that at which the recorder can write the data. This means it is 
possible for Nero Burning ROM 7's internal buffer to be unable to accept any 
more data. This can lead to a situation where the CD/DVD-ROM drive has 
already read audio data in its internal buffer (cache) but has not yet been able 
to "deliver" to Nero Burning ROM 7 because Nero Burning ROM 7's buffer is 
full. This means that the CD/DVD-ROM is forced to reposition the reading 
head. As the CD is turning continuously in the CD-ROM/DVD drive, the 
reading head has to jump back to a previous position. Many CD/DVD-ROM 
drives cannot adjust the reading head for audio CDs accurately and therefore 
sometimes invalid audio data is transmitted. 

  

 
Direct copying of discs requires at least one drive for reading and one for writing.

  

1. Start Nero Burning ROM 7. 

2. If you have installed a recorder that can burn a number of media types (e.g. 
CDs, DVDs), then click on the drop-down list box and select the media type to 
be copied. 

 
  

3. Select the 'CD Copy' compilation. 

4. Click on the 'Copy Options' tab and deactivate the 'On the fly' check box.  
Click on the drop-down list box and select the desired drive.  
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5. Insert an empty disc in the drive, close the tray and click on the 'Burn' button to 
burn the copy. The burn window will appear and you can track the progress. 
The outcome of the burn process is displayed once it is finished. Click on 'OK' 
to finish or on 'Burn again' if the compilation should be burned again. 
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5 DVD erstellen 

5.1 DVD-Video erstellen 
With Nero Burning ROM 7 you can burn a DVD if the DVD-Video title is already 
available. If, on the other hand, you would like to convert video files into a DVD-
Video title, you can use Nero Vision 4 but not Nero Burning ROM 7. 

  

1. Start Nero Burning ROM 7. 

2. Click on the drop-down list box and select the 'DVD' media type. 

 
  

3. Select the 'DVD-Video' compilation, thereby bringing the 'ISO' tab to the 
foreground. 

4. Click on the 'New' button to finish selection of the compilation. The Nero 
Burning ROM 7 file browser opens in which you select the files to be burned. 

5. Select all available files of the DVD-Video title on the right-hand side of the file 
browser and drag them to the left-hand side. 
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6. Click on the  icon to switch to the burn area. You are then ready to 
burn the DVD. For more information on how to do this, please read the 
chapter 'Burning a disc'. 

5.2 Creating a DVD-ROM (ISO) 
The only difference between creating a DVD-ROM (ISO) and creating a CD-ROM 
(ISO) is that you select the 'DVD' media type instead of 'CD'. All other points are 
identical and are therefore not explained here again. Please read the chapter 
'Creating a CD-ROM (ISO)'. 

5.3 Creating a bootable DVD-ROM 
The only difference between creating a bootable DVD-ROM and creating a 
bootable CD-ROM is that you select the 'DVD' media type instead of 'CD'. All 
other points are identical and are therefore not explained here again. Please read 
the chapter 'Making bootable CDs'. 

5.4 Creating a DVD-ROM (UDF) 
The only difference between creating a DVD-ROM (UDF) and creating a CD-
ROM (UDF) is that you select the 'DVD' media type instead of 'CD'. All other 
points are identical and are therefore not explained here again. Please read the 
chapter 'Creating a CD-ROM (UDF)'. 

5.5 Creating a DVD-ROM (UDF/ISO) 
The only difference between creating a DVD-ROM (UDF/ISO) and creating a CD-
ROM (UDF/ISO) is that you select the 'DVD' media type instead of 'CD'. All other 
points are identical and are therefore not explained here again. Please read the 
chapter 'Creating a CD-ROM (UDF/ISO)'. 

5.6 Copying a DVD 
The only difference between copying a DVD and copying a CD is that you select 
the 'DVD' media type instead of 'CD'. All other points are identical and are 
therefore not explained here again. Please read the chapter 'Copying a CD'. 

Nero Burning ROM 7 DVD erstellen  •  62 



6 About burning 

6.1 Choose Recorder 

Clicking on the  icon opens the dialog that shows the installed recorder and in 
which the recorder to be used for burning is selected. Even if there is no recorder 
installed, following installation of Nero Burning ROM 7 the recorder dialog will 
show at least one recorder, namely the 'Image Recorder' with which you can 
save a compilation to your hard drive as an image file. You can subsequently 
burn this image file using Nero Burning ROM 7 or view it using Nero 
ImageDrive. When you select a recorder, important and useful information will be 
displayed such as the media types to be burned, the firmware, etc. 

 
  

Clicking on the 'Options' button opens the additional 'Preferences' area. The 
contents of this area depend on the recorder selected. This area is of particular 
importance in the case of DVD recorders if the book type setting is to be changed 
when burning DVDs. 
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6.2 Burning a disc 

If you have completed your compilation and clicked on the  icon or if 
you have made your copying settings, you will be on the 'Burn' tab where you can 
make your final settings and start the burn process. Nero Burning ROM 7 will 
automatically set the burn options to the optimum value so that you do not have 
to do anything other than click on the 'Burn' button. 

  

1. Check the options selected in the 'Action' area and change them if necessary. 

2. Check the options selected in the 'Writing' area and change them if necessary. 

3. Insert a disc and click on the 'Burn' button. 

 
  

4. The burn process is started; while it is running you can specify whether the 
files burned onto the disc should be verified and/or the PC shut down after the 
burn process (provided this is technically possible and you have the 
administrator rights required for this). 
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5. The outcome of the burn process is displayed once it is finished. Click on 'OK' 
to finish or on 'Burn again' if the compilation should be burned again. 
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6.2.1 Viewing a log file 

After the burn process you can view the burn log and print or save it. 

 
  

1. Click on the 'Details' button to display the burn log. 

 
  

2. Read through the burn log. You can also save and/or print the log if you wish. 
To do so, click on the appropriate button and enter a name to save the log file 
or select the desired printer to print it. 

 
  

3. Click on the ‘OK’ button to close the window. 
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6.3 Additional information for advanced users 

6.3.1 The Burn tab 

On the 'Burn' tab you can make all of the settings required for the burn process. 

 
  

Determine maximum speed 
The speed test determines how quickly the compiled files can be accessed. If the 
access speed is slower than the burning speed, the burning speed is reduced so 
as to avoid a buffer underrun. 

  

 
It is not necessary to run the speed test when using recorders with buffer 
underrun protection. 

  

Simulation 
The simulation runs all the steps involved in burning a medium apart from 
activating the laser beam, so that you can assume that if the simulation is 
successful, the burning process will also be successful. 

We recommend running a simulation if you are decompressing data before 
burning, e.g. when burning an audio CD from MP3 files. To play MP3 files on a 
CD player, the files have to be converted to the corresponding format (CDA). In 
Nero Burning ROM 7, this decompression takes place during the burning 
process. It takes up computer time, which can result in a buffer underrun on older 
systems. Pentium 3 systems or higher can decompress data and burn at high 
speeds simultaneously. 

  

 
You do not need to run simulations if you are using a recorder with buffer 
underrun protection. 

Nero Burning ROM 7 About burning  •  67 



  

Write 
This checkbox starts the actual physical burning process. If this is interrupted, the 
result will be faulty and the entire medium may become unusable, depending on 
the type of medium. Only recorders with buffer underrun protection can continue 
to burn in such cases. 

  

Finalize CD 
When a CD is finalized, it is ‘locked’ and can no longer be burned. Depending on 
the type of medium you are burning, this is a necessary process which enables 
the medium to be used to the full extent. All the options are correctly set in Nero 
Burning ROM 7’s default settings.  

  

Write Speed 
This drop-down box contains the write speeds supported by the recorder you 
have selected. This field is only displayed when you select a physical recorder 
and not the Image Recorder. 

  

Write Method 
There are two alternative methods available for burning media: 'Disc-at-once' 
(DAO) and 'Track-at-once' (TAO). 

Disc-at-once 
With 'Disc-at-once', the whole medium is written in one go without deactivating 
the laser. In the 'Disc-at-once/96’ (DAO/96) process, more data is written, which 
can produce better results for actions such as copying CDs. 

  

 
Audio, Video and Super Video CDs should always be burned using Disc-at-once 
even though it is also possible to select Track-at-once. We do not recommend 
using Track-at-once. It is better to use Disc-at-once/96 for copying CDs. 

  

Track-at-once 
With 'Track-at-once', every track is written individually, which means that the 
laser is switched off after every track. 

  

Number of Copies 
This field contains the number of disks you wish to burn, whereby the standard 
setting is for one disk to be burnt. Enter the required number if you wish to burn 
more disks. 

  

Buffer Underrun Protection 
This checkbox is only present if the selected recorder supports a method which 
offers buffer underrun protection. The standard setting is for this box to be 
checked, as this protection ensures reliable burning of CDs. 
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Use Multiple Recorders 
If multiple recorders are installed, they can be used to burn disks simultaneously. 
When the checkbox is activated, a window will appear after clicking on the ‘Burn’ 
button in which the desired recorders can be selected. 

  

Virus Check Before Burning 
This checkbox is only available to owners of a retail version of Nero Burning 
ROM 7. When the box is checked the data which are to be burned are checked 
for possible viruses before burning. This ensures that the burned disk is virus-
free. 

6.3.2 Book Type bestimmen 

The Book Type field on a DVD helps the DVD player to identify the type of disc 
that has been inserted and to determine how compatible it is with the player. With 
some DVD recorders, Nero Burning ROM 7 can change the Book Type setting 
when a DVD is burned. The Book Type setting is selected when the recorder is 
selected. 

  

1. In the ‘Recorder’ menu, select the ‘Choose Recorder’ command or click on 

. 
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2. To go to the Book Type settings, click the ‘Options’ button at the bottom of the 
‘Choose Recorder’ dialog. 

 
  

3. At ‘Book Type settings’, click the drop-down button, and select a setting from 
the following list: 

 
  
Automatic Nero Burning ROM 7 automatically selects 

the most compatible Book Type for this disc. 
DVD-ROM Changes the Book Type to 'DVD-ROM'. 
Physical disc type Uses the Book Type specified on the 

inserted DVD. 
Current recorder setting Sets the Book Type to the current default 

setting on the recorder. 
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6.4 Use Multiple Recorders 
Owners of the retail version of Nero Burning ROM 7 can also burn 
simultaneously on more than one recorder if they have more than one installed. 
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7 Image file 

7.1 What is an image file? 
An image file is the exact copy of the data on a disk. You can burn copies of this 
image file as often as you like. You can view the contents of the image file and 
simulate one or two drives with Nero ImageDrive. 

7.2 Creating an image file 
Here is a step-by-step guide to creating an image file using Nero Burning 
ROM 7: 

  

1. From the Recorder menu select the command Choose Recorder and select 
Image Recorder (and not the currently installed recorder). Then confirm this 
selection using OK. 

 
  

2. Next create a CD-ROM or audio compilation as described in the appropriate 
sections. 

3. Click on the , button to start the burn dialog. 

4. Click on the Burn button to start creating an image file. 

5. Enter a name in the image file dialog box which opens and define the location 
for saving the file. The compilation files will be written to this image file, i.e. the 
image file will be at least as big as the files of the compilation in total. Now 
click on the Save button to start creating the image file.  
Nero Burning ROM 7 now carries out all the necessary stages as defined. A 
status window will appear showing the stages implemented and informing you 
how the burn process is progressing. As soon as Nero Burning ROM 7 has 
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finished the write process a window will appear containing the message "Burn 
process successful". 

6. Click on the OK button to close the dialog box.  

 

7.3 Burning an image file 
1. Start Nero Burning ROM 7. 

2. Click on the 'Open' button. 

 
  

3. Select the desired image file and click on the 'Open' button to select the file 
and close the window. You are then ready to burn the disc. For more 
information on how to do this, please read the chapter 'Burning a disc'. 
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7.4 Nero ImageDrive 
Nero ImageDrive allows virtual CD/DVD drives to look and work like real drives. 
Load any CD/DVD image in your additional drives and access individual files and 
programs of the image directly via Windows Explorer – without burning them first! 

Nero ImageDrive supports up to two image drives at the same time. The virtual 
drives are added to the existing drives and are each assigned a drive letter. This 
means that you can treat the image files like inserted discs. This is particularly 
beneficial if you require fast access to the disc, as often happens when gaming 
for example. 

7.4.1 Installation of Nero ImageDrive 

Nero ImageDrive is not automatically installed during installation of Nero 
Burning ROM 7. It is only installed if required, using a separate installer. Please 
proceed as follows to install Nero ImageDrive: 

1. Please click on: Start > Programs > Nero > Nero 7 > Nero ImageDrive Installer 

2. You will now be taken through the installation process. When the installation 
has been completed successfully you will be asked to reboot the system. 

3. Nero ImageDrive is now installed and ready for use. 

7.4.2 Activating drives using Nero ImageDrive 

1. Start Nero ImageDrive either from the system control or by using Start > 
Programs > Nero 7 Premium > Tools > Nero ImageDrive. 

 
Nero ImageDrive consists of two tabs: 'Options' and 'Information'. The 
Options tab is in front. From this window you can see whether an image file 
has been loaded and, if this is the case, the name of this file. The 'Information' 
tab shows the number, type and size of the tracks of the image file. 
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The "info" section contains two entries: 

! 'Image' – this shows you which image file has been selected and/or was 
last selected. If no file name has been entered an image file has not yet 
been selected. 

! 'Status' – this shows you whether the image file given in the 'Image' entry 
has been loaded or not. If no data has been loaded the 'Load' button 
appears in the "Info" section. If a file has been loaded the 'Eject' button 
appears in the "Info" section. This releases the image file again. 

! The '...' button near the "Info" section allows you to select an image file. 

! The 'Load/Eject' button allows you to activate or deactivate the image file. 
By clicking on the 'Load' button you activate the image file and using 
Explorer you can search through the contents of the image file as with a 
CD. 

! If the "Load Image File when Starting Up System" control box is activated 
the given image file is loaded immediately after the system starts and is 
then available to you. 

2. Click on the ... button to select the desired image file in the dialog box. When 
you have clicked on the 'Open' button the image file is loaded automatically 
and is available to you, i.e., you may skip the third point. 

3. Once you have ejected the image file you may load the file by clicking on the 
'Load' button. 

4. Click on the 'OK' button to close Nero ImageDrive. 
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8 Setting options for Nero Burning ROM 7 

8.1 Tabs 
The best way to access the 'Preferences' area in Nero Burning ROM 7 is to go 
to 'File' > 'Options'. 

This window contains tabs where you can change the general settings for burning 
media with Nero Burning ROM 7 to suit your own personal needs. 
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8.1.1 Compilation 

You can change some of the basic settings in this tab. We recommend activating 
all the checkboxes as this makes Nero Burning ROM 7 easier to work with. 

8.1.2 Cache 

This tab is where you define the drive and path for the cache, i.e. the memory in 
which data is stored temporarily before and during burning. If you have more than 
one hard disk installed, we recommend that you check the speed of the various 
disks and use the fastest as the cache. 

The speed test cannot check the speed of network drives. We therefore advise 
you not to choose one of these as the cache. 

8.1.3 Language 

This tab is where all the installed languages are displayed and where you select 
the language in which you want the commands and functions and all entries in 
Nero Burning ROM 7 to be displayed. 

Only the languages you selected during installation are displayed. If you would 
like to use a different language, insert the installation CD and install the 
language. 

8.1.4 Sounds 

This tab is where the sounds played in connection with the various burning 
actions are defined. When Nero Burning ROM 7 is installed, various sounds are 
loaded, but you can also link other sounds to the burning actions. 

When the checkbox is activated, the selected sound will be played. When the 
checkbox is deactivated, the sound will not be played. 

8.1.5 Audio 

This directory shows the directory in which the audio plug-ins are installed. 

8.1.6 Expert Features 

As its name suggests, this tab is for expert users who have some experience with 
burning media. 

The Overburn option should be used with particular caution, as it can damage 
your recorder. Use this option at your own risk. 

For CDs burned in Disc-at-once mode, you have the option of writing a short 
lead-out that creates an additional 12 MB of space. 

You can restore the default settings by clicking on the 'Restore' button. 

8.1.7 Database 

Nero Burning ROM 7 enables audio CDs to be linked to a local database. 
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This may be a user database containing the titles that have been burned with 
Nero Burning ROM 7 or a program database. The program database comes 
from freedb.org and must be loaded onto your PC before use (see 'The Nero CD 
database'). Once you have done this, the title of an inserted CD and the artist are 
(usually) recognized and will not have to be entered manually. 

8.1.8 Ultrabuffer 

This tab allows you to specify how much memory Nero Burning ROM 7will use 
as a RAM buffer. This can either be done automatically or manually. We 
recommend using the Automatic Configuration option so as to achieve an 
optimum relationship between the existing buffer and the buffer reserved for 
burning. 

When setting the buffer manually, make sure that it is not too small, as a large 
buffer will produce more reliable burning results than a small one. 

8.1.9 File Browser 

This tab allows you to change the settings for the File Browser – the heart of the 
Nero Burning ROM 7 compilation window. 

For example, you can specify whether the File Browser should be opened 
automatically when you open Nero Burning ROM 7 and whether file operations 
like Delete or Rename should be confirmed. 

8.1.10 Mics 

This is where you set the options for the user interface, the compilations, burning, 
the database and further settings in Nero Burning ROM 7. 

8.1.11 LightScribe 

Here owners of LightScribe recorders can specify the quality that is selected as 
standard, select the default drive (if there is a number of LightScribe recorders 
installed) and specify whether a LightScribe label should always be printed. 
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9 Saving tracks using Nero Burning ROM 7 

9.1 Saving audio tracks 
1. If you want to save audio tracks from audio CDs onto the hard disk select the 

command 'Save Track' from the 'Recorder' menu. A dialog box will open with a 
list of all drives. 

2. Select the drive which contains the audio CD and click on OK. 

3. Now select all of the audio tracks which you would like to save. 

4. Decide on the output format by clicking on the drop down button in the "output 
file format" field and select the desired format. 
  

 
There are various settings for file formats which you can change if necessary. If 
you want to see or change the current settings for the selected format click on 
the 'Settings' button. 

  

5. Change the file path for the files by clicking on the 'Browse' button and 
selecting the desired directory. 

6. Click on the 'Start' button to begin saving. A status bar shows how much has 
been saved already. When saving ends the box is closed. 

7. Click on the 'Close' button if you do not wish to save any more tracks. 

After making your selection you can burn an audio CD.  

9.2 Saving data tracks 
In addition to the possibility of saving audio tracks as audio files Nero Burning 
ROM 7 also offers the possibility of saving data tracks at this point. 

The result is a Nero image file which can be burnt onto another Disk later or used 
with Nero ImageDrive as a fast Disk. Essentially the effect of this command 
could also be obtained by adding files from the appropriate data track to the hard 
disk and then burning an ISO compilation with the files included in it. However the 
saving of a data track followed by burning offers further possibilities: 

  

! Tracks in unknown formats can also be stored. For example tracks recorded in 
Apple Macintosh HFS format. Nero Burning ROM 7 can be used to back up 
and burn such tracks. This also applies to so-called hybrid CDs which include 
both Macintosh HFS and ISO data. When copying file by file on a PC the 
Macintosh information would be irretrievably lost. This also applies to some 
extensions of the ISO format such as the "Apple Extensions" or to Unix 
"Rockridge extensions". On the other hand if the path via 'Save Track' is taken 
all information on the data tracks is retained. 

! When burning a Nero Burning ROM 7 image file created by Save Track the 
CD does not have to be finalized, unlike a CD copy.  
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Advantage: If you burn this image you can append additional data or further 
sessions to this CD. 

! CD image files can be burnt to CDs which are not finalized and not empty. 
This will, for example, allow you to create a CD containing the information from 
several "small" CDs in the form of several tracks and sessions! The advantage 
of this is making one CD from several CDs with only a small file content. With 
Nero Multi Mounter it is then possible to address the desired "sub-CD" and/or 
appropriate track specifically later on. Procedure for producing such a CD is by 
selecting 'Save Track' for each "small" CD required. Finally, using Nero 
Burning ROM 7, each image file produced is written to a blank disc one after 
the other using the 'Burn Image File' command. With the renowned 
"Autorun.Inf" files this guards against duplication of names which would 
otherwise unavoidably occur when compiling several CDs file by file. Moreover 
installation programs work without any problem when allocated to a defined 
CD data carrier name. 

! If required a copy of multisession CDs can be created using this function. This 
will only work if the data tracks of the multisession CD are not "branched" 
between one another (such branching occurs, for example, when burning an 
ISO multisession CD using Nero Burning ROM 7 with the 'Continue 
Multisession disk' command on the 'Multisession' tab.) The reason for this lies 
in the fact that the 'Save Track' command only applies to unbranched data 
tracks. If this were not the case image files could be created which did not 
contain all the files referred to in them. To then burn such CD images onto a 
CD would be senseless and dangerous because the original references to 
other tracks of the CD would necessarily be lost and/or would refer you to 
"nothing". This would mean that all files and directories originally on other 
tracks would be inaccessible but would be shown in the file directory of the 
CD. When using read access later to a data track burnt in this way read errors 
would appear and data extracted which did not compute. That is why the 
saving of ISO tracks with references embracing all tracks is not supported at 
all in Nero Burning ROM 7. 
  

On the internal functioning of this command: Nero Burning ROM 7 tries first of 
all to find the format of the data tracks. Then all blocks of data tracks are saved to 
the image file. Finally, if necessary, further adaptation work is undertaken to allow 
the data tracks to be burnt onto non-empty CDs. For the experts among you: the 
ISO file system has to be "relocated" if necessary. Do not despair: Nero Burning 
ROM 7 will handle the whole thing for you without you having to give it a thought. 

  

 
Nero Burning ROM 7 controls the saving of ISO and HFS data tracks. The vast 
majority of existing CD ROMs for PCs and Apple Macintosh are saved in this 
format. However if the data on the CD is neither in ISO (PC) nor HFS (Macintosh) 
format the results when burning onto a non-empty CD can be non-functional. You 
can find the format of the data track from the display of the track list after 
selecting the 'Save Track' command. If the appropriate track is displayed neither 
as ISO, HFS, hybrid nor Joliet but only as "data mode 1", without any more 
details, proceed with care! Nero Burning ROM 7 allows you the opportunity to 
save and burn data tracks in unknown formats onto it (for example native Unix 
file systems). Here all blocks of the track are then simply copied 1:1. The 
responsibility for deciding whether you can burn such a track "without relocating 
it" onto a non-empty CD is left entirely up to you.  
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10 LightScribe 

10.1 LightScribe System requirements 
To create LightScribe labels, separate hardware and software system 
requirements need to be considered. 

  

Operating system 
! Windows 2000  

! Windows XP 

! Windows 2003 Server 

! Windows Media Center Edition 2004 or larger 

 

Software 
! Nero 6.6.0.8 (or higher) 

! LightScribe Host Software must be installed 

 

Hardware 
! LightScribe compatible recorder 

! LightScribe suitable disc 

10.2 Printing LightScribe labels 
LightScribe is a process that enables CDs and DVDs to be labeled in the 
recorder. This requires both a suitable burner and a special medium. The label 
side of the media has a special color layer and sometimes also a thermal layer; 
this is heated by the laser in the recorder in such a way that images and text are 
printed on the medium. After burning the compilation, the disc is simply removed 
from the recorder, turned over and the LightScribe label is created. 
  
When a label is created, Nero Cover Designer opens. If you have created disc 
labels before using Nero Cover Designer, then you will be able to create 
LightScribe labels without any problem. For their creation, it basically does not 
matter whether a label is printed on paper and then stuck onto the medium or 
printed directly on the medium.  
You will find full details on how to create labels in the Nero Cover Designer 
manual.  
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10.3 Creating a compilation, and burning and printing 
LightScribe labels 

1. Start Nero Burning ROM 7 and create a compilation. 

2. Click on the  icon and select a recorder that can print a LightScribe label. 

3. If you are not sure whether a LightScribe label will be printed, check the 
settings. Choose 'File' > 'Options' > 'LightScribe' and check if the control field 
'Always print LightScribe Label' is selected. If this is not the case, then please 
select it and click on the 'OK' button to close the tab. 

 
  

4. Click on the button  to go to the area where you can make the burn 
settings and create the LightScribe labels. 
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5. Click the 'Misc' tab to go to the LightScribe settings. 

 
  

6. Either select a label that was previously created with Nero Cover Designer or 
create a new one ('Use label from compilation'). 

 
  

Nero Burning ROM 7 LightScribe  •  83 



7. Click on the 'Create' button to create a new label; this launches the Label 
Editor. 

 
  

Launches the Label Editor. 
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8. Click in the 'Label templates' area on the dropdown button and choose a 
template. You can choose between templates with a label design or an empty 
template (Label template: 'Free style'). 

 
  

9. You can now open an existing label ('Open' button) or create a new label. 
Place the mouse pointer in the processing window and click the right (!) mouse 
button to open the shortcut menu. 
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10. If you want to insert something, then select 'Insert' and choose the element 
required.  

 
  

You can insert various elements, such as an image, line, rectangle, ellipse, 
text or fields. In the following picture, a blue circle, a green rectangle, a photo 
and some text have been inserted. 
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11. If you want to have a background image over the entire disc, then select the 
command 'Background Properties'. 

 
  

12. Choose 'File' if the image already exists as a file, or 'TWAIN' if you want to 
import it, and carry out the appropriate steps.  

 
  
You can see the selected image in the preview window.  
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13. Click on the 'OK' button to close the window and insert the image as a 
background. 

 
  

14. When you are satisfied with the label, click on the 'OK' button to close the 
Label Editor. 
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15. Click on the 'Burn' tab to go to the burn settings. 

 
  

16. Check the burn settings and change them if necessary. Insert a LightScribe 
disc in the recorder and click on the 'Burn' button to start the burn process. 
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In the next window you can follow the progress of the burning process and set 
further options, such as computer shut-down or data checking when burning is 
complete. Do this by activating the appropriate check box.  
 

 
 
When the burning process is complete the disc is ejected. 

17. Please insert a LightScribe disc with the label side facing down into the 
recorder and click on the 'OK' button.  
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Prints the LightScribe label. 

 
  

18. You will be informed when the write process ends. Click on the 'OK' button to 
eject the LightScribe disc. 
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19. The tray opens and a message shows that the burning process completed 
successfully. Click on the 'OK' button to close the window. 

 

10.4 LightScribe FAQs 
What is LightScribe? 

LightScribe Direct Disc Labeling is a new process for labeling CDs and DVDs. It 
enables private and commercial users to easily achieve professional results in 
silk-screen printing quality. First of all, the data are burned on the blank disc by 
laser as normal. The medium is then turned over and placed in the burner drawer 
again. Using the same laser as for burning the data, a precise, iridescent label is 
then produced, which can consist of any text and graphic elements. So you no 
longer need to use a printer, permanent marker or self-adhesive disc labels. 

  

How are LightScribe discs detected? 
LightScribe labels can only be printed on discs having a special surface and 
which have been specially made for this purpose. On insertion, LightScribe 
checks whether the identification for LightScribe discs is present in the center of 
the disc. If the disc is not detected, please go through the following steps: 

a. Check whether you have inserted a LightScribe disc. 

b. Check if the LightScribe disc is sitting correctly in the recorder – with the label 
side facing down. 

c. Clean the center of the disc with a lint-free cloth to remove any dirt or smears. 

d. Place another LightScribe disc in the recorder if the problem has still not been 
cleared. 

  

How good is the print quality? 
LightScribe offers three different levels of quality: Draft, normal and best. 
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With each level of quality there is an improvement in the contrast of image and 
text, though the time to print increases. 

  

How fast can a LightScribe label be printed? 
The time to print a LightScribe label depends on a number of factors: the amount 
of data to be printed, the position of the data on the label, the selected print 
quality and the disc used. 

When printing labels, the LightScribe recorder burns the image and text in 
concentric rings from the inner diameter to the outer diameter. Rings with no data 
are skipped. The thickness of the rings determines the contrast and hence the 
print quality. 

  

What labels can I print? 
Basically, there are three different label print modes: 

Title: Only the name of the disc or compilation appears on the disc. This labeling 
method allows the disc to be identified. 

Contents: Information about the contents of the disc is printed on the disc. This is 
the recommended labeling method if there are a number of discs or compilations 
with the same name. 

Complete: Images and text appears on the disc; these creative elements (almost) 
completely fill the disc and make it unique. The format template for this labeling 
method is called 'Free style'. This is the recommended labeling method for 
important discs or discs with a special content. 

  

Why should I update my LightScribe Host Software? 
For various reasons, a window sometimes appears recommending an update for 
the LightScribe Host Software. The commonest reasons are: 

a. The installed LightScribe Host Software is faulty and needs to be reinstalled. 

b. The installed LightScribe Host Software is not the correct version. 

c. An attempt was made to access a disc that is not certified or is not LightScribe 
compatible. 

  

Establish an Internet connection and click 'Update'. In the window which opens, 
select the option 'Save' and specify where you want the LightScribe Host 
Software to be saved.  

  

 
To install the update you must have Administrator rights.To install the update, 
double-click the file that you have downloaded and follow the instructions of the 
Installation Wizard. 

  

Why is only simplified (generic) printing of the label possible? 
If a LightScribe disc is inserted and the LightScribe Host Software offers 
simplified (generic) printing, then the printing is not optimized for that disc. For 
optimal printing results, an update of the LightScribe Host Software is 
recommended and the corresponding window opens.  
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Establish an Internet connection and click' Update'. In the window which opens, 
select the option 'Save' and specify where you want the LightScribe Host 
Software to be saved.  

  

 
To install the update you must have Administrator rights. o install the update, 
double-click the file that you have downloaded and follow the instructions of the 
Installation Wizard. 
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11 Miscellaneous 

11.1 Virus Checker 
The Virus Checker is only available with the retail version of Nero Burning ROM 
7. 

For safety reasons, an antivirus program has been integrated into Nero Burning 
ROM 7, which checks the data to be written onto the CD in order to ensure that 
no files with viruses are included on the CD. You can keep the antivirus 
database, which is the key part of any antivirus software, constantly updated via 
the Internet. 

11.1.1 Updating the database 

1. Set up an Internet connection. 

2. Start Nero Burning ROM 7. 

3. Choose Update Antivirus scanner from the Help menu. 

4. In the dialog box which appears, click on OK to start the update. A link is 
created to the FTP server and the database is automatically updated. After the 
update has been successfully completed, you will see a message telling you 
that the database is now up-to-date. 

5. Click on the OK button to close the dialog box. 

  

 
We recommend that you update the antivirus database regularly. 

11.2 Nero Burning ROM 7 level indicator 
The level indicator is at the bottom of the Nero Burning ROM 7 main window. 
The level indicator allows you to tell whether the data you have selected will fit on 
the disc. As data is normally measured in megabytes and audio data in minutes 
of playing time, the Nero Burning ROM 7 level indicator switches between 
megabytes and minutes depending on the type of data being written to CD. A 
blue bar in the level indicator shows the size of the current compilation. 

Standard CDs normally have a capacity of 650 MB (or 74 minutes). There are 
now blank CDs available with a capacity of 80, 90 and 99 minutes. Therefore the 
capacity of blank CDs is currently between 74 and 99 minutes. The Nero 
Burning ROM 7 level indicator attempts to accommodate this by showing a 
yellow line at 74 minutes (or 650 MB) and a red dashed line at 80 minutes (or 700 
MB). 

If you want to move these markings, you can do so using the Nero Burning 
ROM 7 Preferences menu item.  

You should note however that the value you enter here only affects the display of 
the level indicator. It is not possible, by changing these values, to create extra 
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storage space where none actually exists. If you want, you can also switch off the 
display of the level indicator from the Nero Burning ROM 7 Preferences dialog 
box. 

Although the Nero Burning ROM 7 level indicator is useful, as a result of the 
following problems, its accuracy cannot be guaranteed: 

! With the exception of the continuation of multisession CDs, in most cases the 
destination CD is not put in the recorder until a later stage, which means that 
Nero Burning ROM 7 cannot yet tell whether the compilation will fit on the 
destination CD. The sizes given on the level indicator must therefore be based 
on the assumption that an empty CD is being burnt. 

! In the case of ISO compilations, the structure of the data to be burnt is 
relatively complex and dependent on a large number of different factors. The 
creation of this type of structure is too time-consuming to be done in real time. 
This means that until the burning process actually starts, it is not possible to 
determine exactly how much space will be needed for the data on the CD. The 
sizes given on the level indicator are therefore just a good estimate of the 
space needed by a compilation. 

11.3 Overburning 
In theory, both CDs and DVDs can be overburned, however overburning is 
dependent on so many aspects when it comes to DVDs (recorder, firmware, 
media) that it is not recommended. It goes without saying, however, that even 
DVDs can be overburned if the appropriate option is set. It is and will remain an 
option exclusively for expert users. The overburn process is therefore explained 
for CDs only. 

11.3.1 What is overburning? 

The number of minutes of music or megabytes of data which will fit on the disc is 
printed on every blank CD. You can check the capacity of your disc using the 
'Disc Info' item on the 'Recorder' menu. When you overburn a blank CD, the size 
of the disc is ignored by Nero Burning ROM 7 and data is written to the disc 
beyond the specified capacity. It is clear that ignoring the capacity of the disc 
entails a certain amount of risk. 

This applies both to 74 and 80 minute CDs. In addition the CD standard contains 
a restriction which states that there are no CDs available with a capacity larger 
than 80 minutes. This means that all CDs are seen by Nero Burning ROM 7 as 
80 minute CDs even if they are sold by the manufacturer as, for example, 99 
minute CDs. You can only write 99 minutes of audio to the CD by overburning. 

11.3.1.1 What makes overburning possible? 

The capacity specified by the manufacturers of blank CDs is the minimum size of 
the writable area on the CD. The manufacturing tolerances mean that the actual 
writable area is larger than the specified capacity. This additional area is often 2-
3 minutes long, but can be significantly shorter or longer. 
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11.3.1.2 Risks involved in overburning 

! Read errors, sound interference, incorrectly written data  
The end of the writable layer can be of poorer quality than the rest of the disc, 
which means that read errors can occur at the end of the disc or in areas 
outside the normal storage area of the disc. In the case of audio CDs this 
means unexplained errors, all types of sound interference and the audio CD 
player hanging at the end of the CD. For data CDs it means that it is not 
possible to read a number of files. 

! Error messages during the burning process  
The burning process may be interrupted near the end by an error message, 
such as 'Write emergency' or 'Track following error'. However, the CDs can 
often be read almost up to the end, despite these error messages. The point 
on the disc at which errors may occur is dependent on the make of the blank 
disc and the type of recorder. As there is no way of telling the exact excess 
capacity of a CD automatically, you will unfortunately need to make a few 
experiments. 

! Damage to the recorder  
The third and most unpleasant problem is the possibility of damaging the 
recorder. In practice this is unlikely to happen. 

11.3.1.3 Is it always possible to overburn? 

No 
CDs can only be overburnt in disc-at-once mode. It is not possible to exceed the 
specified capacity of the blank disc in track-at-once mode. 

In addition, some recorders are not able to overburn. Using Nero Burning 
ROM 7, it is easy to find out whether or not your recorder can overburn: 

! From the 'Recorder' menu, choose the item 'Choose Recorder' and select your 
recorder from the list. You will find information about whether the recorder 
supports overburning in the recorder information box. 

11.3.2 Overburning a CD 

1. First check whether your recorder can overburn or not. From the Recorder 
menu, choose the item Choose Recorder and select your recorder from the 
list. You will find information about whether the recorder supports overburning 
in the recorder information box. 

2. Activate the overburn option within Nero Burning ROM 7. From the 'File' menu, 
choose 'Options' and then click on the 'Expert features' tab.  
Activate the checkbox which allows overburning and specify the maximum CD 
length. In theory you can choose any size up to 99 minutes and 59 seconds. 
Initially you should enter a length 2 minutes longer than the specified capacity. 
If SCSI/ATAPI errors occur at the end of the simulation or burning process, we 
recommend that you reduce the maximum overburn capacity or use a different 
make of CD. If no errors occur, you can gradually increase the overburn 
capacity. 

3. Click on OK to confirm the change and close the dialog box.  
This setting will have the following effect on the burning process:  
If the amount of data to be burnt is larger than the normal capacity of the blank 
CD, but less than the maximum overburn capacity, Nero Burning ROM 7 will 
ask at the beginning of the burning process whether you really want to 
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overburn. If you answer yes to this question, Nero Burning ROM 7. will start 
the burning process. If you answer no, the burning process will be aborted 
because there is not enough space on the destination CD. 

11.4 Automatic system shutdown at the end of the 
burning process 

Nero Burning ROM 7 can, if you want, shut down Windows and switch off your 
computer at the end of the burning process. 

In some cases the PC cannot be automatically switched off, although you have 
selected the shutdown option. This may be for one of the following reasons: 

! The energy saving and/or ACPI options in the BIOS are deactivated. 

! The PC does not support 'software power off'. Only ATX motherboards (not AT 
motherboards) support this. 

! ACPI support is not correctly installed. 

! An application installed on the PC which is still active is preventing the PC 
from being switched off automatically. 

! Some older motherboards have problems with ACPI support. If problems 
occur, make sure that you are using the most recent BIOS from the 
motherboard manufacturer. 

In this case, check your Windows installation and the BIOS options. Sometimes it 
is also helpful to install the CD driver which was supplied with the motherboard. 
Most of these driver CDs contain Windows drivers or patches which enable 
Windows to carry out a 'software power off'. As a general rule, if Windows does 
not shut down automatically when you press Alt+F4 and choose 'Shutdown', 
Nero Burning ROM 7 will not be able to shut Windows down automatically. 

  

 
If you do not have administrator rights for operating systems as of Windows 2000 
you cannot be authorized to shut down the PC as you do not have the necessary 
rights. 

11.4.1 Activating automatic system shutdown 

Points to note 
We strongly recommend that you close all other applications when the shutdown 
option is activated. 

The reason for this is that all open applications are closed when the system is 
shut down automatically. Some applications may ask, for example, if the current 
document should be saved. In this case, Windows will not permit Nero Burning 
ROM 7 to shut down the system, because data from other applications could be 
lost. 

  

How to activate automatic system shutdown 
1. Create a compilation in the usual way and start the burning process. 

2. In the burning process dialog box activate the check box 'Automatically shut 
down the PC when done'. 
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11.5 Verifying compilations with Nero Burning ROM 7  
You can use the 'Verify' function to check whether the disc was correctly written. 

11.5.1 Writing data to a CD or DVD involves more risks than writing data 
to a hard disk. 

On the one hand, not every blank disc is compatible with every recorder. On the 
other hand it is possible for dirt from the atmosphere to get into a recorder, which 
is not sealed in the same way as the disks in a hard disk unit. The Verify option 
allows you to check the data you have written quickly and easily. It is particularly 
useful when backing up very important data. You can use the option to make 
sure that you can restore all the data in the event of a system crash. It would be 
disastrous to find out only after the system had crashed that there were faulty 
sectors on your backup disc or that the files had not been written correctly. If you 
use the Nero Burning ROM 7 Verify function at the end of the burning process, 
you can be sure that the disc can be read and that all the files have been written 
correctly. 

11.5.2 Using the Verify option 

To use the Verify option, you must check the 'Verify written data' checkbox in the 
burning process status dialog box. This allows you to choose every time you 
create a disc, whether you want to check the data you have written or not. 

11.5.3 How the Verify option works 

After the data has been written to the disc, Nero Burning ROM 7 ejects the disc 
and reloads it. After this, all the files in the compilation are compared and Nero 
Burning ROM 7 checks whether the files have been written correctly. In 
multisession compilations, Nero Burning ROM 7 checks only those files which 
were written during the most recent burning process and ignores all other files. At 
the end of the check, Nero Burning ROM 7 displays a summary. This contains 
the information from the checking process: the number of identical files, the 
number of different files and the number of files which could not be accessed. 

11.6 Erasing data from rewritable discs 
Using Nero Burning ROM 7 you can not only create CDs and DVDs, but also 
erase rewritable discs (CD-RWs, DVD+RWs and DVD-RWs). However, you can 
only do this if you have a recorder which can also write to these types of disc. 

  

1. From the Recorder menu, choose Erase ReWritable. 

2. Click on the drop-down list and select the desired recorder or check the 'Use 
multiple recorders' box if all of the installed recorders are to be selected. 
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3. Choose the erase method you want by clicking on the button next to the pull-
down list and selecting the erase method and speed.  
There are two erase methods available: 'quick-erase' and 'full-erase'.  
 
Quick-erase: The data is not erased fully from the disc. Only the references to 
the contents of the disc are deleted. The disc appears to be empty, although it 
is not really empty. This means that it is possible for someone else to restore 
the contents. Do not use this method for discs which contain confidential data. 
Erasing a disc using this method lasts between 1 and 2 minutes.  
 
Full-erase: All the data is deleted from the disc and cannot be restored. The 
time needed to erase a disc using this method varies depending on the type of 
disc. 

4. Click on the 'Erase' button. The erase process starts immediately and a dialog 
box is displayed with information about the status of the process. When the 
erase process is completed, the dialog box closes and you can write new data 
to the rewritable disc using Nero Burning ROM 7 or InCD 4. 
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12 FAQs 

12.1 General questions about Nero Burning ROM 7 

12.1.1 Can Nero Burning ROM 7 burn and copy CDs on the fly? 

Yes. Nero Burning ROM 7 can copy CDs on the fly. 

1. In the 'New compilation' dialog box, click on the 'CD-Copy' icon or 

from the 'Recorder' menu choose the Copy Disk item. 

2. On the Copy options tab check the 'On the fly' checkbox. Select your 
CD/DVD-ROM drive as the drive with the source CD. 

12.1.2 How do I create a CD image file? 

To create a image file with Nero Burning ROM 7, you use the so-called 'Image 
Recorder'. You can select this recorder using the Choose Recorder item on the 
Recorder menu. The Image Recorder behaves in the same way as a real 
recorder, but writes the data into an image file instead of onto a CD/DVD. When 
you write a compilation using the Image Recorder, Nero Burning ROM 7 
prompts you to enter the name of the image file and then creates the file. 

Please bear in mind that image files can be large. Make sure that you choose a 
destination drive with enough free space for the file. 

If you want to burn the image file onto a CD/DVD later, we recommend that you 
also choose a fast drive. Network drives are not a good choice in this respect, as 
they also handle other users' jobs which means that they can suddenly become 
very slow. As a result there can be a risk, when burning a CD/DVD from an 
image file, of the data being sent too slowly, which may cause errors on the 
CD/DVD. 

12.1.3 I have entered my serial number, but I cannot open Nero Burning 
ROM 7. Why is this? 

Why is this? You probably have a demo version of Nero Burning ROM 7 which 
has expired. Please contact us to obtain either a new demo version or a full 
version of Nero Burning ROM 7. 

12.1.4 How can I avoid 'Buffer underrun' errors? 

! Defragment your hard disk periodically. 

! Close down all other programs while burning the CD. This applies in particular 
to programs which use a lot of processor time or memory, or which carry out a 
lot of hard disk accesses. The best thing to do is to close all other programs. 
This includes virus scanners which may be running in the background and 
which scan every file which is opened. Instead, you can use Nero Burning 
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ROM 7's integrated virus scanner (only available in the retail version), to 
ensure that there are no viruses on your CDs. 

! If you are using a Notebook, make sure, before you start burning a CD, that 
you have switched off all the energy saving functions (e.g. hard disk 
shutdown, slowing down the processor speed, etc.) from the Control Panel. If 
the computer almost comes to a halt while burning, it will, of course, cause the 
burning process to fail. 

! Carry out a speed test and a simulation before burning the CD. 

! If you want to be completely safe, choose a lower burning speed before you 
start. This means that the burning process will take longer, but it does give you 
maximum safety. 

! If you are buying a new recorder, choose one which has buffer underrun 
protection. 

12.1.5 I can't select any language other than English. 

Nero Burning ROM 7 supports more than 20 languages. 

If the Settings > Language tab lists only one language, you can either reinstall 
Nero Burning ROM 7 with the language settings you want, or you can download 
the appropriate language file from our website: 
http://www.nero.com/en/download.htm. 

12.1.6 Since I installed Nero Burning ROM 7, my computer is behaving 
unpredictably. What is the cause of this? 

Please check the following: 

! If you have CD recording software other than Nero Burning ROM 7 installed, 
there may be driver conflicts. For this reason, Nero AG has written a boot 
menu for Windows 95 and 98 users. This allows you to choose either Nero 
Burning ROM 7 or another CD recording package while you are starting up 
the computer. You can download the boot menu from: 
http://www.nero.com/en/download.htm 
If your PC is running Windows Me, 2000 or XP, you cannot use the boot 
menu. With these operating systems, we recommend uninstalling the other CD 
recording package. 

! IDE/ATAPI recorder: The problems may be caused by an old WinASPI driver 
layer. If you are a registered Nero Burning ROM 7 user, please get in touch 
with Nero AG Support. Send an e-mail to techsupport@nero.com. 

! IDE/ATAPI recorder: If you have installed a busmaster driver, you will find that 
many older busmaster IDE drivers are not compatible with recording 
programs. 

12.1.7 I can read the CD/DVD that I have burnt in my recorder, but not in 
all CD/DVD-ROM drives. Why is this? 

Please check whether you have burned to a rewritable disc. Rewritable discs can 
only be used in recorders with 'multiread'-capable drives. If you want to ensure 
that your CDs/DVDs can be read in any drive, use CD-Rs and not CD-RWs. 
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12.1.8 How do I remove the irritating 2-second pause between audio 
tracks? 

To create an audio CD without pauses between the tracks, follow these 
instructions: 

  

1. In the compilation window, select those audio tracks which you don't want a 
pause before. 

  

 
Die Pause von 2 Sekunden vor dem ersten Audiotrack kann nicht entfernt 
werden. Diese Pause wird von den Audio CD-Playern nicht abgespielt, da das 
Abspielen von CDs immer erst nach Ende der ersten Pause beginnt. 

  

2. From the 'Edit' menu, choose the 'Properties' item or right-click in the 
compilation window and then choose 'Properties' from the pop-up menu. 

3. A dialog box appears in which you can set the length of the pause. Here you 
can enter '0' as the pause length. 

4. Click on the 'OK' button to save the settings and close the dialog box. 

12.1.9 The audio CDs which I have burnt have sound interference such 
as crackling, humming or rustling. Why is this? 

Your problems are probably caused by so-called audio jitter. This is the result of 
fundamental hardware problems when reading audio data. You can resolve the 
interference problems as follows: 

  

! read the CD more slowly or, if possible, at 1X speed, or 

! select the Nero Burning ROM 7 jitter correction function, or, if you can't 
resolve the problem in any other way, 

! use more suitable hardware to read the audio data. This applies in particular 
to CD/DVD-ROM drives. It is a good idea to buy high-quality hardware from a 
well-known manufacturer. You may find it helpful to look at test reports in one 
of the many computer magazines. 

12.1.10 One of the following error messages appears during the 
burning process. Why is this? 

! 'Buffer underrun', 'Write error, padding blocks added' or 'Dummy blocks 
added' and sometimes also 'Logical block out of range': 
Meaning: The memory or buffer which contains the data to be written to the 
CD is empty, which means that no data is being sent to the recorder. As the 
burning process requires a constant datastream, this means that the process 
has been aborted. Try using a slower writing speed and ensure that your PC is 
working at full speed (close down all other programs during the burning 
process, defragment your hard disk before you start, close down background 
processes such as virus scanners etc., switch off energy saving mode and 
screen savers, etc.) 
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! 'Queueing failed', 'Wait queue failed' or 'Reset occurred' or the computer 
hangs with ATAPI recorders. 
Meaning: This is often caused by communications problems between the 
adapter and the CD recorder. With SCSI devices you can try to reduce the 
write speed of the adapter by switching off the 'Sync Negotiation' option and 
setting the transfer rate to half the maximum rate. You can normally do this in 
the controller BIOS. It may help to upgrade the driver software for the SCSI 
host adapter (that is the Miniport and WinASPI driver). You should also check 
that all SCSI devices are correctly terminated and that the SCSI bus is not too 
long. If you have an ATAPI recorder, the problem could be caused by the 
WinASPI drivers. It may also be that you have master/slave ATAPI settings 
which are incorrect or not ideal, or that the devices are not connected in the 
best way to the IDE bus. The best thing to do is to give the recorder its own 
IDE bus (there are normally two). 

  

! 'Cannot recover from PMA', 'Cannot recover from calibration area', 
'Focus or tracking error', 'Laser adjustment error', 'Monitor ATIP error', 
'Power calibration error', 'Write append error', 'Write emergency 
occurred', 'Spindle servo failure' or 'OPC execution error'. 
Meaning: These error messages result from unspecified hardware faults in the 
recorder, which do not have any obvious cause. A firmware upgrade, 
changing to a different make of blank CD or having the recorder repaired may 
all help in this case. 

  

! 'Servo error', 'Track following error', 'Mechanical positioning error'. 
Meaning: This may be caused by a hardware fault, or a firmware upgrade may 
be needed. 

12.2 Context-sensitive help 
Nero Burning ROM 7 has extensive context-sensitive help. 

If you do not understand a software function, an option or some other part of the 
software, simply click on the icon in the toolbar. The mouse pointer will change to 
the  icon. Now click on the item which you would like help with. 

You can also get help by pressing 'F1'. However, the help which appears 
(contrary to the Windows standard) does not refer to the entire dialog box, but 
only to the field with input focus in the dialog box or to the field where the mouse 
pointer is. 

Nero Burning ROM 7 FAQs  •  104 



12.3 Contact 
Nero Burning ROM 7 is an Nero AG product.  
  

 

 
  
Nero AG  
Im Stoeckmaedle 18  
76307 Karlsbad  
Germany  
  
Web:  http://www.nero.com
Help: http://support.nero.com/
Mail:  techsupport@nero.com
Fax: +49 7248 928 499 

 

Copyright © 1995 - 2006 Nero AG. All rights reserved. 
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We are happy to help with questions and problems. Please make sure that you fill 
out the form below. This will make it much easier for us to answer your questions 
quickly. Thank you in advance for your help. 

Software: 
! Nero Burning ROM 7 version (all 4 digits) 

! Windows version (98, 98SE, Me, Windows 2000, Windows XP) 

! Windows 2000, Windows XP: the service pack version 

! Any other Windows upgrades installed 

! The name of any other CD recorder software installed (and any previously 
installed software together with the version number) 

Hardware 
! The names of the recorders connected to your PC and the firmware used 

! The names of the CD/DVD drives 

! The IDE/ATAPI drives 
Primary port – master: 
Primary port – slave: 
Secondary port – master: 
Secondary port – slave: 

! The device control type for all devices: (go to Device Manager > CD-
ROM/Disk drives > <<YOUR DRIVES>> > Properties > Settings) 
– DMA (if available) 
– Disconnect 
– Auto Insert Notification 

! Busmaster drivers: (go to Device Manager > Hard disk controllers) 

! If connected, the names of the following devices and the connection type 
(USB, SCSI, parallel...): 
- Scanner: 
- Printer: 
- ZIP / JAZZ drive: 
- all other externally connected devices. 

! The name of the motherboard and the chipset (see the motherboard or 
computer manual) 

! On PCs running Windows 95/98/ME: Are there any exclamation marks in the 
device manager and if so, where? We recommend removing these 
exclamation marks. Generally it helps to upgrade the drivers for the devices in 
question and/or to resolve all resource conflicts. 

! If the error occurs during the burning process, please send us the log file 
which can be saved at the end of the burning process or simulation. This file 
will give us the basic information which we need to be able to solve the 
problem. Please send us the log file if you can.  

The most important thing is a detailed description of the problem and of the exact 
steps which led up to the problem. Please remember that any piece of 
information, however small, which you can give us concerning your system, may 
help us to solve the problem more quickly. 
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13 Glossary 

Buffer underrun 
To burn a CD, there must be a continuous flow of data. If the datastream 
between the computer and the recorder is so small that the buffer is empty, the 
writing process is interrupted, as there is no data available to write to the CD. 

CD-Text 
As well as audio data, there is space on the CD for a wide variety of additional 
information, such as text describing the title and artist on each track. Currently 
very few audio CD players have a CD text function. If an audio CD player does 
not support CD text, it can play CDs with CD text in just the same way as it does 
"normal" audio CDs without CD text. This is possible because the additional CD 
text information is stored before the start of the audio data in the lead-in area of 
the CD. 

You must have a CD recorder which supports CD text in order to be able to write 
CD text to a CD. You can only write CD text in DAO recording mode (disc-at-
once). You can find out whether your recorder supports this feature in the Nero 
Burning ROM 7 Choose Recorder dialog box. 

CD EXTRA 
CD EXTRA is a Blue Book standard recording format. It was previously called 
CD-Plus and CD-Enhanced (Enhanced CD). This format has none of the 
disadvantages of standard mixed mode CDs. On mixed mode CDs the first track 
always contains an ISO file system, which means that audio CD players cannot 
play the first track of this type of CD. In contrast, CD EXTRA has two sessions. 

The first session contains up to 98 audio tracks conforming to the Red Book 
standard. The second session contains the ISO track with the ISO9660 file 
system and the directories CDPLUS and PICTURES. This means that CDs in CD 
EXTRA format can be played on both CD drives and audio CD players, as the 
second session cannot be "seen" by the audio CD player. 

CD-i 
The CD-i format (Compact Disc Interactive) was developed by Philips and Sony 
and is described in the Green Book. This format is particularly suited to the 
creation of interactive multimedia applications. These applications consist of sub-
programs which can access animations and video and audio sequences. Usually 
special players with television screens are used to play CD-i media. 

DAE 
DAE is the acronym for Digital Audio Extraction. This means that the music tracks 
on audio CDs are read in digital format. This is also referred to as audio grabbing. 
Not all CD-ROM drives can read music in digital format. Generally, CD-ROM 
drives read music tracks in analog format (via the sound card). Using the Nero 
CDSpeed program, you can measure the DAE quality of CD drives. 

Nero Burning ROM 7 Glossary  •  107 



Fast copying 
This is a write process which does not involve storing the data to be written to the 
CD on the hard disk first. The data is written directly onto the blank CD. Another 
term used for fast copying is "on the fly". 

Disc-at-once 
This is a write process which does not create links between the individual 
sessions. The recorder starts by writing the lead-in, which is followed by the data 
and the lead-out. This process is used primarily by manufacturers of audio CDs. 

Disc-at-once/96 is an extension of Disc-at-once which gives the software better 
control of the burning process. This mode is preferable, if it is available. 

DVD 
DVD stands for Digital Versatile Disc. It was originally referred to as Digital Video 
Disc. 

The purpose of developing DVDs was to create a medium which could hold 
significantly more data than a CD-ROM. You can store two layers of data on each 
side of a DVD. The first layer can hold 4.7 GB and the second layer 3.8 GB, 
which means that a single-sided DVD can store 8.5 GB of data. DVDs can only 
be read by DVD drives, which can also read CD-ROMs. Unfortunately many DVD 
drives are not able to read CD-Rs. Even fewer can read CD-RWs. 

Currently the following types of DVD are available: 

! DVD-Audio: A high capacity audio medium. 

! DVD-R: DVD-Rs can store between 3.95, 4.7 and 9.4 GB of data. In order to 
store 9.4 GB, you must use the second side of the DVD-R which means that 
you have to turn it over. 

! DVD-RAM: This is a rewritable medium which can store either 2.6 GB (one 
layer) or 5.2 GB (two layers) of data. 

! DVD-ROM: This is the data medium. 

! DVD-RW: This is a rewritable DVD which can be read by almost any standard 
DVD-ROM drive or DVD player. DVD-RW drives can also read and write to 
DVDs which are not rewritable. DVD-RWs have a storage capacity of 4.7 GB. 
The difference between these and DVD-RAMs is that they can also be played 
in standard DVD-ROM drives and standalone DVD players. 

! DVD+RW: This is a rewritable DVD which can be read by almost any standard 
DVD-ROM drive or DVD player. DVD+RW drives can also read and write to 
DVDs which are not rewritable. DVD+RWs have a storage capacity of 4.7 GB. 
The difference between these and DVD-RAMs is that they can also be played 
in standard DVD-ROM drives and standalone DVD players. 

! DVD-Video: DVD-Videos contain full-length feature films with high audio and 
video quality. The videos are encoded in MPEG-2 format. 
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Additional information: 

! The UDF (Universal Disc Format) file system is used on DVDs. However the 
data can also be accessed via an ISO9660 data system which is also included 
on the DVD. 

! DVD format no longer corresponds to any of the formats specified in the 
colored books. 

El Torito 
El Torito is a specification which describes the structure of a CD used to boot a 
PC. A PC with a suitable BIOS can start the operating system from the CD and 
therefore does not need a floppy disk or a hard disk. 

Finalizing 
Finalizing is similar to fixing, but applies to the entire disc. No additional data can 
be written to a finalized disc. When you burn a CD or DVD in DAO mode, the disc 
is automatically finalized. However, the data on a finalized CD-RW can still be 
deleted (by choosing the Erase ReWritable item from the Recorder menu). 

Firmware 
The firmware in recorders (CD/DVD-ROM drives) functions as the operating 
system of the drive and contains instructions which determine how the drive 
reacts to commands from the computer. The firmware of the latest recorders can 
generally be upgraded. For example, Nero AG's website contains a page with 
links to the latest firmware versions. To see the firmware version of your drive, 
use the Choose Recorder menu item on the Recorder menu in Nero Burning 
ROM 7. 

Fixing 
Fixing is similar to finalizing, but applies only to an individual session rather than 
to the whole CD. Fixing means closing the session which has just been written, 
so that it can be read. To do this, the lead-in and lead-out data are written to the 
disc. In the current version of Nero Burning ROM 7, sessions are always fixed 
automatically. 

Image file 
This is a writing process which involves creating a physical image of a file. The 
contents of the image correspond exactly to the data which will be written to the 
CD. 

Grabbing 
Grabbing is digital audio extraction that is reading audio tracks on a CD in digital 
format. 
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Index positions 
You can set index positions within an audio track. These index positions allow 
you to move to specific points within the track using an audio CD player. 
Unfortunately, very few audio CD players have the functionality which allows 
them to move to index positions. 

Please note that index positions are not the same as the start and end of tracks. 
All audio CD players can move from one track to another on a CD, but very few 
can read and move to index positions within a track. 

Hybrid CDs 
A hybrid CD contains files for more than one operating system. Generally, the 
term hybrid CD is used to refer to CDs which can be read by PCs running 
Windows and by Macs. If the data is to be accessible to both operating systems, 
there must be two copies of it on the CD. 

Lead-in 
This is an area at the beginning of each session. However, it is only written to the 
CD when the session is completed. The lead-in contains the table of contents 
(TOC) of the session. 

Lead-out 
This is an area at the end of each session which is written at the same time as 
the lead-in. 

m3u playlist 
An m3u file contains a list of MP3 file paths. An m3u file can be created, for 
example, by NeroMIX or WinAmp. Nero Burning ROM 7 can process m3u files, 
which means that when you are creating an audio CD, you simply have to drag 
and drop the m3u file into the audio window. 

Mixed mode CDs 
A mixed mode CD has one initial data track followed by audio tracks. This usually 
means that audio CD players cannot process the first track. If you are creating 
audio CDs to be played on a CD player, it is better to use the CD EXTRA format, 
because on this type of CD the data follows the audio tracks. 

MPEG 
MPEG stands for Motion Pictures Expert Group (www.mpeg.org).  This 
international committee regulates the uniform compression of video and 
multimedia (video, film and audio) data. The MPEG standard now consists of 
MPEG-1, MPEG-2, MPEG-3 and MPEG-4. The MPEG-3 standard has now been 
integrated with MPEG-2. 
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MPEG-1 
This format was developed for moving video reproduction, and has the highest 
compression rates. The drawback of this is that the resolution is relatively poor. 
Video CDs (VCDs) are encoded in MPEG-1 and can contain up to 79 minutes of 
film material. 

MPEG-2 
MPEG-2 is the successor of MPEG-1, which was known for the video CD (VCD). 
MPEG-2’s flexible compression standards provide excellent image quality at 
extremely low bitrates.  It is used for DVD videos and Super Video CDs (SVCDs).  

The DVD plugin enables you to generate SVCD-compatible MPEG-2 files and 
burn a Super Video CD, which can contain around 40 minutes of film material. 
Average bitrate for an SVCD is around  2.3 Mbits per second. 

With the MPEG-2/DVD plugin, you can create both DVD-compatible MPEG-2 
files and SVCD-compatible MPEG-2 files. This means you can fit about two hours 
of film material on a DVD.  The average bitrate for a DVD video is around 4.8 
Mbits per second. Please note that you need Nero Vision 4 and Nero Burning 
ROM 7  to encode video files with the MPEG-2/DVD plugin and burn the DVD. 

MP3 / mp3PRO 
MP3 is an acronym (or file extension) for "MPEG Audio Layer 3". These are 
compressed audio files which can be played on a computer using an MP3 player. 
(MPEG stands for Motion Pictures Expert Group, which is a US standards 
organization responsible for full motion video standards.) MP3 was developed by 
the Fraunhofer Institute IIS and is restricted to audio data, in the same way as 
mp3PRO, which was developed by Coding Technologies. 

Nero Burning ROM 7 can compress both MP3 and mp3PRO files, both of which 
have the file extension MP3. MP3. The quality of the signal depends on the 
compression rate. The standard rates are 64 kbps at 44100 Hz stereo for 
mp3PRO and 128 kbps at 44100 Hz stereo for MP3. During the encoding 
process the original WAV file is generally reduced to about 5 percent of its 
original size in mp3PRO format and to about 10 percent in MP3 format. The 
encoding process is lossy, but the psychoacoustic models remove only those 
parts of the audio file which are considered to be inaudible. Audible parts of an 
audio file can only be lost at a high compression rate. 

Nero Burning ROM 7 allows you to convert 30 files into MP3 or mp3PRO format. 
For licensing reasons, it is not possible to convert more files. You can find both 
the plugins which allow unlimited encoding on Nero AG's website: Nero AG 
Webshop. 
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MP4-AAC 
MP4 is an acronym (or file extension) for "MPEG Audio Layer 4". These are 
compressed audio files which can be played on a computer using an MP4 player.  

AAC is part of the MPEG-4 standard has so far been used mainly for commercial 
purposes. The MPEG-4/AAC encoder works about 30% more efficiently than 
MP3 and has fewer problems with critical samples. This gives better quality for 
the same file size. Multichannel sound is also possible.  

The quality of the signal depends on the compression rate. The norm with MP4 is 
128 kbps at 44100 Hz, stereo. Encoding reduces the original WAV file to around 
10% of its original size. The encoding process is lossy, but the psychoacoustic 
models remove only those parts of the audio file which are considered to be 
inaudible. Audible parts of an audio file can only be lost at a high compression 
rate. 

With Nero Burning ROM 7, you have 30 days to convert up to 50 files into MP4 
format. For licensing reasons, it is not possible to convert more files. You can find 
the plugin which allows unlimited encoding on Nero AG's web site: Nero AG 
Webshop.  

Nero (Nero Claudius Caesar) 
Nero was born in 37 A.D. and died in 68 A.D. He was Roman emperor from 54 to 
68 A.D. He was the son of Agrippina, and was adopted by the Emperor Claudius. 
Seneca was appointed as Nero's tutor and Nero was brought up by his 
stepfather to be his heir. In 53 A.D. he married Octavia, Claudius' daughter. The 
first years of his reign were relatively calm, largely due to the influence of 
Seneca. Nero respected the Senate and the existing order. Poets hailed him as 
the initiator of a new golden age. Later he had his mother Agrippina murdered 
and banished his wife who had not provided him with an heir. He became 
increasingly tyrannical and rid himself of his more levelheaded advisers. He 
made eccentric public appearances as an artist and charioteer, he prosecuted 
citizens for treason and after the great fire in Rome in 64 A.D. threw suspicion for 
having started it on the Christians. The suspicion that Nero himself started the 
fire cannot be proved, but it indicates what his citizens thought he was capable 
of. However, there was no real systematic persecution of Christians, since the 
events which took place were restricted to the city of Rome. After the failure of 
plot against Nero hatched in the Senate and lead by Piso, repression increased. 
Uprisings in Gaul, Spain and Africa caused the Praetorian Guard to withdraw its 
allegiance to Nero. The Guard then declared its support for Galba as emperor 
and the Senate declared Nero to be hostis populi Romani (an enemy of the 
Roman people), upon which he committed suicide. His death marked the end of 
the Julian-Claudian imperial dynasty. 

On the fly 
This is a write process which does not involve storing the data to be written to the 
CD on the hard disk first. The data is written directly onto the blank CD. Another 
term used for on the fly is "fast copying". 

Packet CD / Packet writing 
This is a write process which involves sending the data in blocks to the CD-RW 
drive without first creating an image file. The CD-RW drive is used in the same 
way as a hard disk or floppy disk, which means that any application can write the 
data to the CD. CDs created using packet writing can only be read with a special 
UDF driver. 
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PCM 
PCM is the main standard for digitizing audio files and speech. PCM stands for 
pulse code modulation and involves digitally encoding analog signals. 

Pre-gap 
This is also referred to as a pause. It is the area on a CD which separates one 
track from another. In Nero Burning ROM 7 the default pause is set to 2 
seconds (Red Book standard). 

Session 
CDs are divided into tracks and sessions. A session consists of all the files which 
are written to the CD in the course of one write process and can consist of one or 
more tracks. There can be more than one session on a multisession CD. 

Simulation 
Simulation corresponds to the process of writing data, except that no data is 
written. Simulation is used to check whether the data can be sent to the recorder 
quickly enough to avoid a buffer underrun. It can also be used to check whether 
the recorder can actually write to the CD. You should use simulation when you 
are not sure whether the system can send the data quickly enough. If you have 
already burnt a few CDs successfully, you can switch off simulation. If your 
recorder has a buffer underrun protection function, you do not need to use 
simulation. 

Track 
On an audio CD a track corresponds to a piece of music. On a data CD a track is 
a unit of data which joins consecutive sectors together. 

Track-at-once 
This is a method of writing data which is used for multisession CDs. The CD-RW 
drive writes all the tracks one after another and does not end the session until 
this is finished. 

UDF (Universal Disk Format) 
This is a file system developed by OSTA (the Optical Storage Technology 
Association). With a UDF driver and packet writing, data can be written to a CD 
drive in the same way as to a hard disk or floppy disk drive. 

Volume descriptor 
The volume descriptor is added to every CD track. It contains information such as 
the creation data, the publisher, the title etc. The volume descriptor has a special 
significance for formats such as Video CD, Photo CD and CD-i. The volume 
descriptor on these types of CD includes information about the program to be 
used for reading the data on the CD. 

Virtual Image 
A virtual image is a project file which contains only references to the files which 
are to be written to CD. 
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White Book 
The White Book is a standard which is more commonly called Video CD. 

XSVCD (Extended Super Video CD) 
XSVCD stands for Extended Super Video CD. The difference between this and 
SVCD is that the average bit rate can be anything up to 9.8 Mbit/s, whereas with 
SVCD it is 2.6 Mbit/s. Unfortunately not all drives which can read Super Video 
CDs support this format. In order to burn an XSVCD using Nero Burning ROM 7, 
you must deactivate the "Create standard compliant CD" checkbox on the Video 
CD tab.  

XVCD (Extended Video CD) 
XVCD stands for Extended Video CD. The difference between this and Video CD 
is that the bitrate can be anything up to 3.5 Mbit/s, whereas with VCD it is 1.5 
Mbit/s. Unfortunately not all drives which can read Video CDs support this format. 
In order to burn an XVCD using Nero Burning ROM 7, you must deactivate the 
"Create standard compliant CD" checkbox on the Video CD tab.  

Yellow Book 
The Yellow Book is the standard for the format of CDs used for data storage. As 
the data must not contain any errors, additional error correction data is included. 
This additional error recognition and correction data is included in Mode 1. In 
Mode 2 this information is not included and therefore this mode is only suitable 
for less error-prone data such as the video files on Video CDs. 
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